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Welcome

Welcome to Sterling Commerce�s GENTRAN:Server® electronic commerce 
software.

Who should use
this guide

This guide is for all users of the GENTRAN:Server for UNIX or GENTRAN:Server 
Workstation products, version 6.0.

Description of
content

This guide documents procedures for Application Integration subsystem 
(Application Integration Mapper) and the Visual Mapper. Unless otherwise stated, 
the procedures for using these mappers are the same. 

Use the following table to determine which part of this guide will be most useful for 
you.

Reference
See the topic GENTRAN:Server Mappers for a comparison of the Application 
Integration Mapper and the Visual Mapper.

Assumptions This book assumes that you are familiar with basic Windows concepts and 
commands, including:
◗ How to navigate and operate within the Windows environment
◗ How to use DOS commands and the DOS window from within the Windows 

desktop.

In addition, if you are using the GENTRAN:Server for UNIX product, this book 
assumes that you are familiar with basic UNIX concepts and commands.

IF your company� THEN you will�

is purchasing 
GENTRAN:Server for the first 
time

refer to chapters 1, 2, and 3 for information

purchased GENTRAN:Server 
version 5.4

refer to chapters 1, 2, and 3 for information

purchased GENTRAN:Server 
version 5.3 or prior

refer to chapters 1, 2, 3, and 4 for information
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Chapter Contents

Description of
contents

This table describes the content of the chapters within the Getting Started Guide.

Chapter Title Description

About This Guide Explains the content, organization, and 
conventions in this guide, and how to get help 
if you encounter problems. 

Introducing GENTRAN:Server Describes the basic architecture of the 
GENTRAN:Server software.

Using GENTRAN:Server Explains how to start and exit 
GENTRAN:Server, describes the user 
interface, and explains how to set default 
values for your system.

Working with Application 
Integration

Contains procedures for working with 
Application Integration Mapper files in 
Workstation and UNIX. Includes instructions 
for checking out, saving, and checking in files.

Working with the Visual 
Mapper

Contains procedures for working with Visual 
Mapper files in Workstation and UNIX. 
Includes instructions for checking out, saving, 
and checking in files.
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Related Publications

GENTRAN:Server
documentation

This table describes additional documentation for the GENTRAN:Server software.

Document Description

Upgrade and 
Conversion Guide

Instructions for upgrading from previous versions of 
GENTRAN:Server Workstation and GENTRAN:Server 
for UNIX. Also includes instructions for converting the 
files that are part of the upgrade.

GENTRAN:Server for 
UNIX Installation and 
Setup Guide

Instructions for installing the GENTRAN:Server 
software and performing setup tasks, such as setting 
up security.

GENTRAN:Server 
Workstation 
Installation 
Instructions

Instructions for installing the GENTRAN:Server 
Workstation software and performing setup tasks.

Application 
Integration User�s 
Guide

Instructions for performing mapping and translation 
tasks. 

Mapping and 
Translation Guide

Instructions for performing mapping and translation 
tasks using the GENTRAN:Server Visual Mapper.

Note
This guide is provided only if you maintain maps 
created with GENTRAN:Server version 5.3 or prior.

NCPCP User�s Guide Instructions for mapping and translating NCPDP files 
with the Application Integration system.

XML User�s Guide Instructions for mapping and translating XML files with 
the Application Integration system.

Note
This guide is provided only if your organization has the 
GENTRAN:Server XML translation option.

ODBC User�s Guide Instructions for mapping and translating ODBC files 
with the Application Integration system.

Note
This guide is provided only if your organization has the 
GENTRAN:Server ODBC translation option.

(Continued on next page)
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(Continued on next page)

GENCOD User�s 
Guide

Instructions for mapping and translating GENCOD files 
with the Application Integration system and the Visual 
Mapper.

VDA User�s Guide Instructions for mapping and translating VDA files with 
the Application Integration system and the Visual 
Mapper.

Technical Reference 
Guide

Describes processes, lists command-line commands in 
alphabetical order, and describes file record layouts 
and data type formats.

Data Flow 
Administration Guide

User instructions for configuring data flows using the 
GENTRAN:Server for UNIX software.

Note
This guide is provided only if you have the 
GENTRAN:Server EC Workbench or higher product 
level. 

Maintenance and 
Troubleshooting 
Guide

Instructions for maintaining your GENTRAN:Server 
installation. Also provides troubleshooting information 
to help determine the cause and solution of problems 
that may occur.

Advanced Data 
Distribution Guide

Instructions for configuring and using the 
GENTRAN:Server Advanced Data Distribution 
product.

Note
This guide is provided only if you have 
GENTRAN:Server with Advanced Data Distribution. 

FTP Daemon User�s 
Guide

Instructions for configuring and using the FTP Daemon 
tool with the Advanced Data Distribution product.

Online Help Context-sensitive help screens describing the 
GENTRAN:Server dialog boxes for the mapping and 
translation features. Also includes procedures for using 
the mapping and translation and the data flow 
administration software.

 (Contd)
Document Description
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Documentation Conventions

Typographic
conventions

This table describes the typographic conventions used in this guide.

Convention Use

Italics This typeface is used for titles of other manuals and 
documents, names of files and file extensions, and to 
emphasize important information.

Example
GENTRAN:Server Application Integration Guide

Bold Bold type is used for names of fields on a dialog box, 
key terms the first time they are used within a chapter, 
and entries you are to make on-screen.

Example
A password is a set of characters a user must enter to 
gain access to a system.
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How to Get Help

Introduction This topic explains how to contact Sterling Commerce Product Support if you 
need assistance with GENTRAN:Server.

Scope of
Support

Services

Sterling Commerce Product Support can provide assistance and information for 
the following:
◗ Installing GENTRAN:Server
◗ GENTRAN:Server product questions
◗ Software revisions and upgrades
◗ Implementing a specific feature 
◗ How to use GENTRAN:Server
◗ The status of your support call
◗ Requests for product enhancements

Unfortunately, Sterling Commerce Product Support cannot assist you with 
problems involving the following, but we may be able to suggest a next step or 
another vendor to call:

◗ Your hardware
◗ Your operating system or other system software
◗ Your application or user-written programs
◗ Software not developed by Sterling Commerce
◗ Scripts written by Sterling Commerce consultants or service partners

Try this first Before you call Sterling Commerce Product Support, use your online software 
manuals to locate the section that documents the program or feature where you 
are having problems. The documentation may explain the software�s behavior or 
give you insight to help you solve the problem.

Consult the GENTRAN:Server Maintenance and Troubleshooting Guide to learn if 
your specific problem has been addressed.

(Continued on next page)
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Copy this page Please feel free to make a copy of this page to enable you to contact support 
quickly and with complete information for the Customer Support Representative.

Necessary
information

Be ready to provide this information when you call Product Support.

Your name

Your company name

Your telephone number

Your GENTRAN:Server version number 

Your GENTRAN:Server product level and platform

Any software add-ons to your GENTRAN:Server system

A detailed description of the problem

(Continued on next page)
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How to contact
support

To determine how to contact support for your geographical location, go to the 
Sterling Commerce home page (www.sterlingcommerce.com) and then go to 
Customer Support for GENTRAN.

The sequence of steps that led to the problem

What actions you have taken to try to diagnose or resolve the problem
Getting Started Guide � February 2002
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Introduction

Welcome Welcome to GENTRAN:Server®, the electronic data interchange (EDI) software 
that makes it easy to manage data exchanges between you and your trading 
partners. The heart of electronic data interchange is the translation of data into 
and out of formats that are intelligible to computerized data management 
systems. 

GENTRAN:Server enables you to exchange data with your trading partners. 
When you send application data, GENTRAN:Server converts your data into EDI 
standard formats that can be understood by your trading partners. When you 
receive data in a standardized format, GENTRAN:Server translates the data into 
a format your application can understand.

You use GENTRAN:Server to describe your applications, edit standards, maintain 
trading partnership information, and generate translation �maps,� which are sets 
of instructions for translating data.

Note
If your company purchased the XML translation option, you can also exchange 
data in XML format. See the GENTRAN:Server XML User�s Guide for more 
information.

In this chapter This chapter contains background information about GENTRAN:Server that you 
should know before beginning to use the software.

Key terms This table describes key terms used in this chapter.

Term Description

application The business software generating the business 
information that you are sending or receiving 
electronically.

client The computer in a client/server network that acts as the 
interface between the user and the server.

client/server A computer network architecture in which data is stored 
and processing is performed on the server, which users 
access through the interface provided on the client. 

(Continued on next page)
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default A value that is automatically assigned.

EDI Electronic Data Interchange.

Application-to-application transfer of key business 
transaction information in a standard or XML format via a 
computer-to-computer communication link.

EDI standard A format to regulate syntax, structure, and content of 
transaction data.

map A file that contains the relationships between:

◗ The segments and elements of a standard EDI 
document and the data fields in your application,

◗ The elements in an XML document and the data 
fields in your application, EDI standard document, or 
in another XML document,

◗ The segments and elements of two different 
standards, or

◗ The records and fields of two different applications.

master directory The directory on a PC or on a server that stores your 
master files.

master file The version of a map that GENTRAN:Server uses to 
process data. 

server The computer in a client/server network that performs 
the major system security, data storage, and computing 
tasks.

standard format A format intelligible to computerized data management 
systems.

temporary file A file on the client that GENTRAN:Server uses during 
editing and compiling.

trading partner The company, division, or group with which you are 
exchanging business data electronically.

Trading Partnership An arrangement to exchange information in a specific 
document type with a specific trading partner and using a 
particular standard version.

(Continued on next page)

 (Contd)
Term Description
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user directory The directory on the server that temporarily holds the 
files being transferred from a client�s working directory to 
the master directory on the server.

working file A file that is stored in the user�s working directory on the 
client while the user has it checked out for editing.

working file directory The directory created on the client to hold the files that a 
user is editing.

 (Contd)
Term Description
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GENTRAN:Server Features

Introduction This summary lists the features GENTRAN:Server provides for your translation 
needs.

Product versions There are two basic versions of GENTRAN:Server:
◗ GENTRAN:Server Workstation, which runs on a PC
◗ GENTRAN:Server for UNIX, which runs on a client/server architecture

GENTRAN:Server
Workstation
architecture

The Workstation architecture provides:
◗ A Windows® interface.
◗ All files and processing on one machine.
◗ Single-user configuration; no file-sharing or security limitations.
◗ Standard GENTRAN:Server functions.

GENTRAN:Server
for UNIX

architecture

The client/server architecture provides:

◗ An interface with a Windows look and feel.
◗ UNIX® computing power for processing-intensive tasks.
◗ Multi-user capability.
◗ System and file security.
◗ Availability of optional products, such as Advanced Data Distribution.

Multiple Help
sources

GENTRAN:Server provides Help through:

◗ Wizards to guide you through the key record-creation processes.
◗ Online Help with task-oriented content.
◗ Documentation provided on CD-ROM for online access.

(Continued on next page)
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Automated
functions

The following features automate many tasks for you.

Archiving
◗ Stores and retrieves both EDI and user-defined data
◗ Tracks key EDI activities; provides reports and audit trails of translations

Functional Acknowledgments
◗ Handles inbound and outbound functional acknowledgments and 

reconciliation
◗ Provides status information for each document

Task Scheduler
◗ Runs processes such as upload and download, translation, communications, 

and other tasks in a totally unattended mode

Mappers There are two mappers available in GENTRAN:Server 6.0:

◗ the Application Integration subsystem (Application Integration Mapper)
◗ the Visual Mapper

Reference
See the topic GENTRAN:Server Mappers for a comparison of the Application 
Integration Mapper and the Visual Mapper.
GENTRAN:Server Getting Started Guide � February 2002



Introducing GENTRAN:Server GENTRAN:Server Mappers 1 - 7
GENTRAN:Server Mappers

Introduction This topic discusses the differences between the Application Integration Mapper 
and the Visual Mapper.

Which mapper to
use

GENTRAN:Server 6.0 is available to new and existing customers. The mapper 
you use depends on the version of GENTRAN:Server your company was using 
before purchasing GENTRAN:Server 6.0. Use the following table to determine 
which mapper you will use.

Illustration The illustration identifies the Application Integration Mapper and the Visual 
Mapper buttons.

Creating maps If both the Application Integration Mapper and the Visual Mapper are available to 
you, then you can create maps in either mapper. However, you cannot create a 
map in one mapper and save it to the other. Similarly, you can only open a map in 
the mapper in which it was created.

(Continued on next page)

IF your company� THEN you�

is purchasing 
GENTRAN:Server for the first 
time

will use the Application Integration Mapper.

purchased GENTRAN:Server 
version 5.4

will use the Application Integration Mapper.

purchased GENTRAN:Server 
version 5.3 or prior

will use the Application Integration Mapper to 
create new maps and the Visual Mapper to 
maintain your current maps.

Application Integration 
Mapper button

Visual Mapper button
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Extensions This table lists the map and associated file extensions.

WARNING
If you are using both the Application Integration Mapper and the 
Visual Mapper, you must be careful NOT to overwrite your .vmp map. 
If the master directory contains a map with the same name as your 
working map, then you must use a different name for your working 
map. This prevents the .map file from overwriting the .vmp file. 
For example, if you are creating a new map in the Application 
Integration Mapper using the XXX.vmp as a guide, then save the new 
map using the file name XXY.map or XXXa.map.
GENTRAN:Server does not recognize map extensions. When you 
check in a working map to the master directory, it overwrites any 
existing map file that has the same file name, regardless of the 
extension.

(Continued on next page)

IF the map is created 
using the�

THEN the map 
extension is�

AND the associated 
file extension is�

Application Integration 
Mapper

.map .tpl

Visual Mapper .vmp .tbl
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Terminology:
Different terms

with same
definition

In many instances, the Application Integration Mapper and Visual Mapper use the 
same terms and meanings. However, there are instances in which two different 
terms share the same definition. The following table lists the common definitions 
with the corresponding terms.

lftran options Both the Application Integration Mapper and the Visual Mapper interface with 
lftran, but the options available are different.

Reference
See the GENTRAN:Server Technical Reference Guide for more information.

Definition
Application Integration 

Mapper Term Visual Mapper Term

The standard transaction 
set GENTRAN:Server 
uses to acknowledge 
receipt of a 
transmission. The 
functional 
acknowledgement tells 
you if your trading 
partner received a 
document you sent.

Acknowledgement Functional 
acknowledgement

A file that defines the 
layout of the records, 
fields, and groups in an 
application file.

File definition (.ddf) Application description 
(.app)

The file that results when 
a map is compiled.

Translation object (.TPL) Mapping table file (.TBL)

Compiled map

A file that shows the 
relationships between 
input and output and 
defines how the system 
should translate the 
data.

map (.map) Map File (.vmp)
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GENTRAN:Server Workstation Strategy

Introduction This topic describes the GENTRAN:Server Workstation architecture.

Description A GENTRAN:Server Workstation installation installs all files on a PC. The PC 
stores the data, houses the user interface, and runs the processes. 

Advantages The Workstation architecture provides the following advantages:
◗ Allows users familiar with PCs to learn quickly and easily how to use the 

GENTRAN:Server interface
◗ Provides a single-user control over data and processes
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GENTRAN:Server for UNIX Client/Server Strategy

Introduction This topic describes the GENTRAN:Server for UNIX client/server architecture.

Description A GENTRAN:Server for UNIX installation consists of a UNIX server (host 
computer) connected by a network to client PCs. The server provides data, 
security, and translation processing, while the client computers provide the user 
interface, mapping tools, and the trading partnership maintenance module. 

Advantages The client/server architecture provides the following advantages:
◗ A user interface with a Windows look and feel to allow users familiar with PCs 

to learn quickly and easily how to use the GENTRAN:Server interface
◗ UNIX computing power for processing-intensive tasks such as performing 

translation, without the expense of a UNIX box for every user
◗ A true multi-user system that allows only one user to edit a file at a time, but 

also allows other users view-only access to locked files
◗ Increased system and file security.

Architecture This illustration and accompanying table show the major components of the 
GENTRAN:Server for UNIX client/server architecture.

(Continued on next page)

Server
 Client

(UNIX)
(Windows)

Communications
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Where
components

reside

This table shows which GENTRAN:Server components reside on the server and 
which on the client.

Environments Environments are installations of the GENTRAN:Server software on the UNIX 
server. Usually, each installation is dedicated to a certain purpose. They are 
physically represented as branches in the directory tree structure and can be 
created for many purposes. They can be especially useful for providing a place to 
test changes without affecting normal activity.

Examples
Some examples of environments created for specific purposes follow.

Installations based on the activity performed: 
◗ Development
◗ Testing
◗ Production

Installations based on the document generated: 
◗ Purchase orders
◗ Invoices

Installations based on the industry of the trading partner: 
◗ Automotive
◗ Aerospace
◗ Medical

(Continued on next page)

Server Client Server or Client

Programs ◗ Translator
◗ Archiver
◗ Security
◗ Utilities

◗ Mapper 
(Application 
Integration 
Mapper and 
Visual Mapper) 
editors

◗ Compiler
◗ Archive viewer
◗ Trading partner 

maintenance

Data ◗ Maps and 
translation 
objects

◗ Trading partner 
records and 
associated files

◗ Temporary files ◗ Standard files 
(Application 
Integration 
Mapper)

◗ Standard files 
(Visual Mapper)
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Security Within each installation, the system administrator can assign different levels of 
access to a user for each of the major functions within GENTRAN:Server.

Functional areas
This table shows the basic functional areas and types of access that the system 
administrator may assign you.

(Continued on next page)

Functional Area Types of Access

Editors Archive Retrieval Full Access

View-only

No Access

File Browser

Trading Partner Preferences 
Settings

Trading Partner Editor

Programs Process Control Manager Full Access

No AccessArchive load/unload/create/
purge

TP/org/category/contact load/
unload/create

Run Program: D-ISAM File 
Operations

Server Workbench

Schedule Tasks to Run 
Automatically

Run Tools

Run Inbound and Outbound 
Translation
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Levels of access
This table describes the different levels of access.

Example
By creating separate environments (installations) and assigning appropriate 
permissions, system administrators can assign users access appropriate to the 
work they perform. For example, a system administrator might have Full 
permission in all environments, while a user whose job is to process reports may 
have only View permission in the production environment and No Access 
permissions in all other environments.

Level of Access Description

Full Access Gives you permission to view, copy, rename, load, 
unload, and edit files.

View Gives you permission to view files, but not to alter 
them.

No Access Prevents you from using an editor, viewing files, or 
running a program.
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Running Multiple Sessions

Definition A session is a single instance of the GENTRAN:Server application running in a 
window on your desktop.

GENTRAN:Server does not limit you to a single session; you can run more than 
one instance of GENTRAN:Server for UNIX client software or GENTRAN:Server 
Workstation at the same time. Each time you start GENTRAN:Server on your 
desktop, you start a new session. Each session runs in a different window. 
Running multiple sessions enables you to perform different GENTRAN:Server 
tasks in each window.

How many
sessions can

you run?

You can run:
◗ Up to four sessions of the GENTRAN:Server for UNIX client software at the 

same time on one Windows desktop
◗ Up to four sessions of GENTRAN:Server Workstation at the same time on 

one Windows desktop
◗ GENTRAN:Server Workstation and GENTRAN:Server for UNIX client 

software at the same time on one desktop.

Example
You run three simultaneous sessions of the GENTRAN:Server for UNIX client 
software for the host1 and environment XYZ combination:

◗ Session 1, view a file with the File Browser
◗ Session 2, search for a Trading Partnership record
◗ Session 3, create a new category

Performance
limitations

Each additional session you start degrades performance. Opening too many 
sessions at once can cause the client to lock.

Login
requirements for

UNIX

When you start another GENTRAN:Server session for a host and environment 
that is running on your desktop, you must use the same user ID and password to 
log onto the new session.

If you want to start a session for a different host or environment, you can use a 
different user ID and password.

(Continued on next page)
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Process and
session limits

If you open multiple sessions on your desktop, the sessions can be for the:
◗ Same host and environment (GENTRAN:Server for UNIX)
◗ Same host and different environments (GENTRAN:Server for UNIX)
◗ Different hosts and environments (GENTRAN:Server for UNIX)
◗ Combination of GENTRAN:Server Workstation sessions and 

GENTRAN:Server for UNIX sessions.

This table shows the limitations on running processes in multiple sessions.

(Continued on next page)

Process Limitations

File Browser None. Multiple windows permitted in each 
session.

Trading Partnership Maintenance None. Multiple windows permitted in each 
session.

Process Control Manager (if 
included)

Once in a session for each host/
environment combination.

SAP Configuration (if included) Once in a session for each host/
environment combination. 

Standard Version Conversion (if 
included)

Once in a session for each host/
environment combination.

Archive Once in a session for each host/
environment combination.

EC Workbench (if included) One client session for each host/
environment combination.

You can run EC Workbench multiple times 
as long as each Client session is for a 
different host and environment 
combination.

Translation One client session for each host/
environment.

You can run translation multiple times as 
long as each session is for a different host 
and environment combination.

Map Compilation One client session at a time.

Mapping None. Multiple windows permitted in each 
session 
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If a process has session limitations and is already running, GENTRAN:Server 
displays a message to let you know that the process is busy and asks that you try 
again later.

File locking GENTRAN:Server locks certain files to prevent you from editing the same file in 
multiple sessions. If you attempt to edit a file that you are editing in another 
session, GENTRAN:Server displays a message to let you know that the file is in 
use.

GENTRAN:Server locks these files when you open them for editing:

◗ Maps
◗ Trading Partner record
◗ Group Organization record
◗ Interchange Organization record

Exceptions
Locking does not apply to:

◗ Files edited in the File Browser
◗ Trading Partnership Category files
◗ Trading Partnership Contact files

Note
If the same non-DISAM file is edited in two different parallel sessions, the last 
changes saved overwrite earlier changes from another session.

Caution
Never use the File Browser to edit an DISAM file. Doing so will corrupt the file. 

Report, log and
local temporary

files

GENTRAN:Server keeps the report files, log files, and local temporary files for 
each host and environment in different directories.

The system creates a directory named rpt for the report and log files under the 
directory where the GENTRAN:Server client software is installed. The local 
temporary working files are stored in the lcltmp directory.

For each host and environment, the system creates a subdirectory under the rpt 
and lcltmp directories. The subdirectory is named for the environment and host 
name (environment+hostname) logged in to for the session.

(Continued on next page)
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Example
The GENTRAN:Server client software is installed in D:\gentran. The system 
creates subdirectories for the report files and for the local temporary files:

◗ D:\gentran\rpt
◗ D:\gentran\lcltmp
You start a session, logging in to the 60test environment on the host hpd350. 
GENTRAN:Server creates subdirectories for the session:

◗ D:\gentran\60testhpd350
◗ D:\gentran\rpt\60testhpd350
◗ D:\gentran\lcltmp\60testhpd350

GENTRAN:Server stores the session�s report and log files in 
D:\gentran\rpt\60testhpd350 and stores the session�s local temporary files in 
D:\gentran\lcltmp\60testhpd350.

You open a session for a different environment and host, 2XF on hpd001. 
GENTRAN:Server creates new subdirectories for the report and local temporary 
files:

◗ D:\gentran\2XFhpd001
◗ D:\gentran\rpt\2XFhpd001
◗ D:\gentran\lcltmp\2XFhpd001

Note
If the host or environment name contains special characters (such as *, ?, <, or >), 
the system converts the special characters to underscores (_). The host name 
hp<200> is converted to hp_200_.
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File Name Conventions

Introduction This topic describes the file name conventions and limitations you must follow 
when you name a GENTRAN:Server file or directory.

Validation When you save or open a file, GENTRAN:Server checks the length of the file 
name and the characters used in the file name. If the file name exceeds the 
maximum length or if the file name includes an invalid character, 
GENTRAN:Server displays a message to alert you of the problem.

Directory and
path name

length

Directory names can be up to 63 characters in length, not counting the slash or 
backslash character used to separate a directory name from a subdirectory name.

The total maximum for a path, file name, and file name extension is 128 
characters.

(Continued on next page)
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File name length This table lists length restrictions of the file names of specific types of 
GENTRAN:Server files:

(Continued on next page)

File Type Maximum Length of Name

Map 60 (plus 4-character extension)

File definition 60 (plus 4-character extension)

Application description 60 (plus 4-character extension)

Implementation guide 60 (plus 4-character extension)

Input file 60 (plus 4-character extension)

Output file 60 (plus 4-character extension)

Mapping table 60 (plus 4-character extension)

Script 14 characters

Data manager 4 characters

Data manager pattern 15 characters

Transaction Register 9 characters

Queue 8 characters
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Character
limitations

This table lists the characters that GENTRAN:Server does not allow in a file 
name.

Character Description

\ Backslash (reserved for separating directory, subdirectory, and 
file names)

/ Slash (reserved for separating directory, subdirectory, and file 
names)

* Asterisk

� Double quotation mark

� Forward single quotation mark

' Backward single quotation mark

< Less-than sign

> Greater-than sign

| Vertical bar

Spaces

@ �At� sign

& �And� character

( Open round bracket

) Closed round bracket

; Semi-colon

: Colon

? Question mark

$ Dollar sign
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Introduction

In this chapter This chapter contains general information about the GENTRAN:Server interface. 
It describes the menus and Toolbar of the Main Window and includes instructions 
for:
◗ Starting and exiting GENTRAN:Server
◗ Using menus, toolbar buttons, and dialog boxes
◗ Using the File Browser to edit text, EDI, and NCPDP files
◗ Changing your password (UNIX version only)
◗ Choosing printing properties
◗ Setting GENTRAN:Server preferences and default values

Key terms This table describes key terms used in this chapter.

Term Description

check box A square to the left of an option in a dialog. When the 
option is selected, the square contains an X. You click 
the check box to change whether the option is selected. 

click The act of quickly pressing and releasing a mouse 
button.

default A value that is automatically assigned.

dialog box A window in the computer interface used to enter 
information into the system.

double-click The act of quickly pressing and releasing a mouse button 
twice.

master directory The directory on a PC or on a server that stores your 
master files.

menu A list of related commands.

menu bar The row of menu names that runs across the top of a 
window.

option button A round button used to select one option from a mutually 
exclusive set of options.

(Continued on next page)
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push-button A symbol or icon that initiates some action when you 
click it.

server The computer in a client/server network that performs 
the major system security, data storage, and computing 
tasks.

text box A box into which you enter alphanumeric text to provide 
data needed by GENTRAN:Server.

Toolbar A bar of buttons used to start commands.

 (Contd)
Term Description
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Starting and Exiting 0

How to Start GENTRAN:Server Workstation

Introduction This topic explains how to start GENTRAN:Server Workstation.

Note
You can run up to four sessions of GENTRAN:Server on the same desktop 
at once.

Procedure Follow this procedure to start GENTRAN:Server Workstation. 

Reference
See the How to Set TP Administration Preferences topic in the Application 
Integration User�s Guide for instructions on setting Trading Partnership 
Administration Preferences.

Step Action

1 Click the Windows Start menu.

2 Select the GENTRAN:Server program icon from the Programs 
menu.

System Response
GENTRAN:Server displays the copyright dialog box.

3 Click OK.

System Response
GENTRAN:Server displays the Main Window.
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How to Start GENTRAN:Server for UNIX

Introduction This topic explains how to start GENTRAN:Server for UNIX.

Starting
GENTRAN:Server

for Unix

Follow this procedure to start and log on to GENTRAN:Server for UNIX. 

Step Action

1 Click the Start menu.

2 Select the GENTRAN:Server program icon from the Programs 
menu.

System Response
GENTRAN:Server displays the Login window. 

3 Type your user name into the User Name box.

Note
When you start another GENTRAN:Server session for a host 
and environment that is running on your desktop, you must 
use the same user ID and password to log onto the new 
session.

If you want to start a session for a different host or 
environment, use a different user ID and password.

4 Type your GENTRAN:Server user password into the Password 
box.

(Continued on next page)
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Reference
See the How to Set TP Administration Preferences topic in the Application 
Integration User�s Guide for instructions on setting Trading Partnership 
Administration Preferences.

5 Select the host server from the Host Name drop-down list.

6 Select an environment from the Environment drop-down list.

7 Click Login.

8 Click Continue.

System Response
GENTRAN:Server displays the main window and logs you 
into the selected host and environment.

Note
The Main menu title bar displays the name of the host and 
environment.

Step Action
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How to Change Your Password (UNIX Version)

Introduction This topic explains how to change your user password for GENTRAN:Server for 
UNIX. 

Note
If you use GENTRAN:Server Workstation, you do not have a password.

Procedure Use this procedure to change your GENTRAN:Server for UNIX password. 

Step Action

1 Click the Start menu.

2 Select the GENTRAN:Server program icon from the Programs 
menu.

System Response
GENTRAN:Server displays the Login window. 

3 Type your user name into the User Name box.

4 Type your GENTRAN:Server user password into the Password 
box.

5 Select a Host Name from the drop-down list.

6 Select an environment from the Environment drop-down list.

7 Click Login.

System Response
GENTRAN:Server enables the Change PSW button. 

(Continued on next page)
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8 Click Change PSW.

System Response
GENTRAN:Server displays the Change Password dialog 
box.

9 Type the new password into both the New Password and Retype 
New Password text boxes. Click OK.

System Response
The system displays the Login dialog box.

10 Click Continue.

System Response
GENTRAN:Server logs you in, changes your password, and 
displays the main window. 

 (Contd)
Step Action
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How to Exit GENTRAN:Server

Introduction This topic explains how to exit GENTRAN:Server.

Before you exit Any files that are checked out when you exit the application remain checked out 
and unavailable for other users to edit. Before you exit GENTRAN:Server, be sure 
to check in any files that you no longer need. 

Reference
See How to Check In Maps and Translation Objects and How to Check In 
File Definitions in the Working with Application Integration chapter or How to 
Check In Compiled Maps, How to Check In Compiled Maps and How to 
Check In Synonym and Thesaurus List Files, in the Working with the Visual 
Mapper chapter for instructions.

Procedure Select Exit from the File menu.

Note
If you are running multiple sessions on your desktop, you must exit each 
session.

System Response
GENTRAN:Server for UNIX logs off of the host computer and exits.

GENTRAN:Server Workstation exits.
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The GENTRAN:Server 
User Interface 0

Overview

Introduction GENTRAN:Server features on the client are Windows-based. To use 
GENTRAN:Server, you must be familiar with using a personal computer and with 
Windows functions and terminology, including the following:
◗ The terminology used to describe mouse and cursor actions; for example, 

opening, clicking, scrolling
◗ The terminology used to describe Windows-specific attributes, such as dialog 

boxes, buttons, and check boxes.

User interface The user interface for all versions of GENTRAN:Server includes:
◗ Screens that use the familiar Windows interface.
◗ Graphical tree organization of trading partnership records to make setup and 

maintenance easier.
◗ Graphic displays of mapping components and relationships.
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The Main Window

Introduction This topic explains the items you see on the GENTRAN:Server Main Window.

Reference
Refer to your Windows documentation for detailed explanations of Windows 
terms and functions.

Main
Workstation

window

This illustration shows the major parts of the main GENTRAN:Server Workstation 
window.

(Continued on next page)

 
Menu bar

Toolbar

Status bar
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Main UNIX
Window

This illustration shows an example of the Main Window for GENTRAN:Server for 
UNIX.

Note
This illustration displays many of the options available with 
GENTRAN:Server. However, you will only see the options your company 
purchased.

Parts of the
window

This table describes the parts of the main GENTRAN:Server window.

Part Function

Menu bar Opens menus to display commands.

Toolbar Starts commands from a set of buttons.

Status bar Displays a status message, prompt, or toolbar button description.

Menu bar
Toolbar

Status bar
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Main Window Menus

Introduction You can start all GENTRAN:Server features and functions from the menus of the 
GENTRAN:Server Main Window.

Workstation
Main Window

menus

This table describes the menus of the Workstation Main Window.

Menu Used to�

File Menu ◗ Check in a file
◗ Check out a file
◗ Unlock a file
◗ Open the Print Setup dialog box
◗ Exit the Main Window

Edit Menu ◗ Start a mapping editor (Application 
Integration or the Visual Mapper)

◗ Start the Trading Partnership 
Administration subsystem

Translate ◗ Open the Translate Documents dialog box
◗ Generate a translation report.

Archive ◗ Set archiving parameters
◗ Open an archive
◗ Purge an archive
◗ Load and unload archived files
◗ Create new archives

XML Configuration (if you 
have the XML translation 
option)

◗ Open the XML Element Configuration 
window

◗ Start the XML Trading Partnership Rules 
wizard

◗ Open the XML TP Cross Reference dialog 
box.

(Continued on next page)
GENTRAN:Server Getting Started Guide � February 2002



Main Window Menus Using GENTRAN:Server2 - 14
(Continued on next page)

Application File Configuration ◗ Start the Application File Trading 
Partnership Rules wizard

◗ Open the Application TP Cross Reference 
dialog box.

Tools ◗ Schedule tasks
◗ Run scheduled tasks
◗ Run Standard Version Conversion
◗ Start the File Browser
◗ Open the Run a Command dialog box to 

run a command line program

Settings Display the Set Up Directories dialog box, 
which enables you to specify or change the 
default directories for your GENTRAN:Server 
files

Window ◗ Display or hide the Toolbar
◗ Display or hide the Status Bar

Help ◗ Open the Help Contents or Index
◗ Display information about using Help
◗ Display version information for 

GENTRAN:Server

 (Contd)
Menu Used to�
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UNIX Client/
Server Main

Window menus

This table describes the menus of the UNIX Client/Server Main Window.

Menu Used to�

File Menu ◗ Check in a file
◗ Check out a file
◗ Unlock a file
◗ Copy compiled maps (.TBL and .TPL) to 

User Directory on host
◗ Open the Print Setup dialog box
◗ Exit the Main Window

Edit Menu ◗ Start a mapping editor
◗ Start the Trading Partnership 

Administration subsystem

Translate ◗ Open the Translate Documents dialog box
◗ Generate a translation report.

Archive ◗ Set archiving parameters
◗ Open an archive
◗ Purge an archive
◗ Load and unload archived files
◗ Create new archives

XML Configuration (if you 
have the XML translation 
option)

◗ Open the XML Element Configuration 
window

◗ Start the XML Trading Partnership Rules 
wizard

◗ Open the XML TP Cross Reference dialog 
box.

Application File Configuration ◗ Start the Application File Trading 
Partnership Rules wizard

◗ Open the Application File TP Cross 
Reference dialog box.

(Continued on next page)
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Tools ◗ Test host connection
◗ Open the Task Scheduler to schedule a 

task
◗ Run scheduled tasks
◗ Run Standard Version Conversion
◗ Start the File Browser
◗ Open the Run a Command dialog box to 

run a command line program
◗ Start optional subsystems, such as the 

Process Control Manager, Workbench on 
a host, or an extension

Settings Specify default directories for your 
GENTRAN:Server files

Window ◗ Display or hide the Toolbar
◗ Display or hide the Status Bar

Help ◗ Open the Help Contents or Index
◗ Display information about using Help
◗ Display version information for 

GENTRAN:Server

 (Contd)
Menu Used to�
GENTRAN:Server Getting Started Guide � February 2002



Using GENTRAN:Server The Main Window Toolbar 2 - 17
The Main Window Toolbar

Introduction The GENTRAN:Server Toolbar consists of several buttons that you can use to 
quickly access GENTRAN:Server subsystems, tools, and optional features.

The specific buttons displayed on your toolbar depend upon the 
GENTRAN:Server product level and options your company has. This topic 
describes the most common buttons. Your toolbar may include additional buttons 
for optional features.

The Main
Window Toolbar

To execute a command with a toolbar button, click the appropriate button. 

Click this� To do this�

Check in files.

Check out files.

Open the Application Integration mapping editor.

Open the Visual Mapper mapping editor.

 

Open the Trading Partnership Administration 
subsystem.

Open the Translate Documents dialog box or generate a 
translation report.

Start an archiving option.

 
Start the Process Control Manager subsystem (available 
in GENTRAN:Server for UNIX only).

Open Data Flow Administration subsystem (available in 
GENTRAN:Server for UNIX only).

(Continued on next page)
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Open the File Browser text editor.

Display Help for the current window.

 (Contd)
Click this� To do this�
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How to Use the GENTRAN:Server Interface

Introduction This topic explains how to use the GENTRAN:Server menus, toolbars, dialog 
boxes, and other interface features.

Using the menus To select a menu command, click the menu name to display the drop-down list of 
commands; then click the desired command. You can also select many 
commands from the keyboard by pressing the short-cut keys displayed to the right 
of the command or by pressing ALT + the underlined letter in the menu item name 
and then the letter underlined in the drop-down list.

Using the
Toolbar

To start a feature or subsystem from the Toolbar, click the appropriate 
Toolbar button.

Note
For information about a Toolbar button, place the pointer on the button to 
display the button�s name and then refer to the Status Bar for the button�s 
function.

(Continued on next page)
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Using the Status
Bar

The status bar displays information, descriptions, or instructions for the active 
window, item on a dialog box, toolbar button, or command. You may see a status 
such as �Ready� for a window, an instruction such as �Enter record ID� for a text 
box on a dialog box, or �File Browser� for a Toolbar button.

To use the Status Bar, move the pointer to the window, box, or button that you 
want to check and then read the text displayed on the Status Bar.

Using dialog
boxes

You enter information within a dialog box by:
◗ Typing in text boxes
◗ Selecting items from list boxes
◗ Clicking check boxes, options, or push buttons. 

To move to the desired box or button, use either the mouse or the keyboard.

◗ When using the mouse, move the mouse pointer to the desired box or button 
and click to select the box or button.

◗ When using the keyboard, press TAB to move to the next box or button or 
press SHIFT+TAB to move to the previous box or button.

Status bar
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How to Use the On-line Help

Introduction GENTRAN:Server provides Help information to guide you through commands and 
procedures. GENTRAN:Server�s Help files explain many topics: parts of the 
active window, commands, dialogs, and procedures for using specific features to 
perform a task.

Getting Help You can get Help several ways. The methods available depend on the window 
you have displayed. 

Using the Help
menu

To learn how to use Help, click Using Help on the Help menu. 

The Contents command on the Help menu displays a list of Help topics that you 
can choose from. You can access Help information for the topics in different ways; 
you can use the menus at the top of the Help window, or you can use the buttons 
under the menus to search for a topic. You can print and edit Help information.

(Continued on next page)

To start Help 
from� Do this�

The menu bar Click a command or topic from the Help menu. 

The toolbar Click the Help button on the toolbar for information about 
the currently displayed dialog box or window. 

Any window Press F1 for information about the window. 

A dialog box Click the Help button on the active dialog box for related 
help information. 

dialog box 
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Using the Help
toolbar button

On major windows, you can get window-level Help by clicking the Help button on 
the toolbar. 

Using the Help
buttons on

dialog boxes

You can get Help for any dialog box that displays the Help button. Click the Help 
button for more information. 

Exiting Help You can close the Help window when you are finished with it. To close the Help 
window, click Exit on the File menu of the Help system menu bar.

Toolbar Help button

Help button
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The File Browser

Introduction The File Browser is a GENTRAN:Server tool that enables you to open and edit 
text, EDI, and NCPDP files. It contains basic text-editing features, such as 
copying, cutting, pasting, finding, and replacing text.

When to use You can use the File Browser to open and edit:
◗ Text files, such as batch files (*.bat) and configuration files (*.cfg)
◗ EDI files
◗ NCPDP files

Note
When you open an EDI file in the File Browser, GENTRAN:Server runs the 
edifrmat command on the file before displaying it. The edifrmat command 
replaces the segment terminators in the file with new line terminators so 
that the format is easier to read.

The File Browser
window

This illustration shows the File Browser window.

(Continued on next page)
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Parts of the File
Browser window

This table describes the parts and functions of the File Browser window.

Part Function

Menu bar Opens menus to display commands.

Toolbar Starts commands from a set of buttons.

Status bar Displays a status message, prompt, or toolbar button 
description.
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How to Use the File Browser

Introduction This topic explains how to start and exit the File Browser, open a file, and use the 
File Browser editing commands to modify a file.

Starting the File
Browser

To start the File Browser, do one of the following:
◗ Click the File Browser button on the Main Window toolbar.
◗ Select Start File Browser from the Tools menu.

Opening a file There are two ways to open a file in the File Browser: from the Toolbar or from the 
File menu.

Method 1 - Toolbar button.

Step Action

1 Click the Open button on the File Browser toolbar.

System Response
The File Browser displays the Open dialog box.

2 Click on Text File, EDI File, or NCPDP File to indicate the type of 
file you want to open.

3 Click OK.

System Response
The File Browser displays the standard Open dialog box.

4 Browse to the folder and file you want to open.

5 Click OK.
(Continued on next page)
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Method 2 - File menu

Select Open from the File menu and then select Text, EDI, or NCPDP from the 
cascading menu.

Editing a file in
the File Browser

This table describes how to edit, print, and save a file in the File Browser.

6 IF you open� THEN the File Browser�

an EDI file displays the Enter EDI Format 
Parameter dialog box.

Continue with Step 7.

a text file displays the text file. You are 
finished. 

a NCPDP file runs the edifrmat command on 
the file you selected and 
displays the file in a newline 
terminated format.

You are finished.

7 Click the option on the Enter EDI Format Parameter dialog box to 
specify the format you want applied to the data.

System Response
The system runs the edifrmat command on the file you 
selected and displays the file in a newline terminated format.

 (Contd)
Step Action

IF you want to� THEN�

Insert characters Click at the insertion point and type the 
characters.

Copy selected text to the 
clipboard

Click Copy on the Edit menu.

Paste text on the clipboard 
into the document

Click at the insertion point and then click Paste 
on the Edit menu.

Select the entire document Click Select All on the Edit menu.
(Continued on next page)
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Exiting the File
Browser

To close the File Browser, do one of the following:

◗ Select Exit from the File menu.
◗ Click the close button on the File Browser window.

Search for characters, words, 
or phrases

Click Find on the Edit menu. Then, enter the 
search string.

Search for the next 
occurrence of a search item

Click Find Next on the Edit menu.

Replace selected text Click Replace on the Edit menu. Then type the 
replacement text.

Print the document Click Print on the File Menu.

Save the changes to the 
document

Click Save on the File menu.

Save a copy of the document 
under a new path or name

Click Save As on the File menu. and enter the 
new path and file name.
GENTRAN:Server Getting Started Guide � February 2002



How to Change Print Properties Using GENTRAN:Server2 - 28
How to Change Print Properties

Introduction This topic explains how to open the Print Setup dialog box from within 
GENTRAN:Server. Check your Microsoft® documentation for details on how to 
use the window.

Background When you print any of the reports that GENTRAN:Server generates, the program 
prints the report on the default printer, using the default font style and size 
specified for that printer. You can use the Microsoft Print Setup dialog box to 
specify print properties for the default printer for the client. 

Your selections affect all printing (except printing of compiler messages) in 
GENTRAN:Server until you quit or you change them by again opening the Print 
Setup dialog. If you want to set these defaults and keep them between 
GENTRAN:Server sessions, use the Printers utility in the Windows Control 
Panel.

Opening the
Print Setup

window

Follow this procedure to open the Print Setup dialog box from within 
GENTRAN:Server.

Adjusting print
properties

Depending upon the font style and size, some parts of the report may not appear 
on the output. (This may be a problem with fonts larger than 12 point). To correct, 
change the default font style or size. The methods of changing the default font 
style and size vary according to your machine. 

Depending upon the aspect ratio of the report, you could also try printing 
landscape instead of portrait. 

Step Action

1 Click File on either the Main, Application Integration Main, Visual 
Mapper, Application Editor, or Standard/IG Editor menu bar.

2 Click Print Setup on the File menu.
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Setting Default Values 0

Overview

In this section This section explains how to set the basic directory and the Application Integration 
Mapper and Visual Mapper preferences and default values you want your system 
to use.

Reference
See the Setting Preferences and Default Values section in the Application 
Integration User’s Guide for information about setting preferences and 
default values for the Application Integration subsystem.

See the Specifying Preferred Default Values section in the Mapping and 
Translation Guide for information abut setting preferences and 
default values for the Visual Mapper.

Default
directories

The Set Up Directories dialog box enables you to define the default directories 
that GENTRAN:Server will use to store your GENTRAN:Server files on your PC or 
client. If you are using GENTRAN:Server for UNIX, your system administrator will 
set the default directories for the server during installation. The server directories 
appear on the screen, but can�t be changed.

When to set the
values

We recommend that you set your default directory and map display values before 
you create your first map. However, you can set or change the map display 
options at any time.

(Continued on next page)
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Where to go next Use this table to locate the instructions for setting particular types of preferences.

IF you want to customize� THEN select�

Workstation or Client

The default directories your 
system uses to store 
GENTRAN:Server files

How to Change the Default Workstation 
Directories (Workstation) or How to Change 
Client Default Directories (UNIX).

Application Integration

All the Application Integration 
Subsystem preferences

How to Set the Application Integration 
Preferences in the GENTRAN:Server 
Application Integration User�s Guide.

The list of date and time 
formats that you can use in 
map fields

How to Set the Application Date/Time Formats 
in the GENTRAN:Server Application 
Integration User�s Guide.

The default date format for all 
date fields used in a map

How to Set the Default Date Formats in the 
GENTRAN:Server Application Integration 
User�s Guide.

Which map component 
descriptions are displayed

How to Customize Component Display 
Options in the GENTRAN:Server Application 
Integration User�s Guide.

Foreground and background 
colours of map components

How to Customize Component Colours in the 
Application Integration User’s Guide

Font type, style, or size used 
in map displays

How to Customize Global Fonts in the 
GENTRAN:Server Application Integration 
User�s Guide.

How map links are displayed How to Customize the Display of Links in the 
GENTRAN:Server Application Integration 
User�s Guide.

How the map version number 
is incremented

How to Customize the Auto-increment Map 
Version in the GENTRAN:Server Application 
Integration User�s Guide.

Visual Mapper

The Visual Mapper 
preferences

Specifying Preferred Default Values in the 
GENTRAN:Server Mapping and Translation 
Guide.
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Set Up Directories Dialog Box

Introduction The Set Up Directories dialog box enables you to define the default directories 
that GENTRAN:Server will use to store your GENTRAN:Server files on your PC or 
client.

GENTRAN:Server
Workstation

This illustration shows the Set Up Directories dialog box for GENTRAN:Server 
Workstation.

Note
The implementation guide directory is grayed out if you do not have the 
Visual Mapper installed.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Workstation Set Up Directories dialog box and their 
functions.

(Continued on next page)

Field Function

Standards Stores a list of available standards.

Note
If you have Visual Mapper capabilities, then this 
directory also stores the actual standards.

Implementation Guide Stores implementation guides (.igs)

Note
The Implementation Guide directory is grayed 
out if the Visual Mapper is not installed on your 
computer system.

File Definitions/Apps Stores file definitions (DDFs).

Note
If you have Visual Mapper capabilities, then this 
directory also stores the application description 
files.

Maps Stores map files and translation objects.

Trading Partner 
Records

Stores Trading Partnership files.

EDI Status Audit Stores the status audit files that GENTRAN:Server 
generates.

EDI History Audit Stores the history audit files that GENTRAN:Server 
generates.

User Files Stores your user files.

Text/Help Files Stores text files and the GENTRAN:Server Help files.

Data Files Stores your data files.

Report/Log Contains the reports and log files that 
GENTRAN:Server generates.

Default Check In/Out Serves as the default working directory for files.

Default TPL/TBL 
Location

Serves as the default working directory for translation 
objects (compiled maps).
GENTRAN:Server Getting Started Guide � February 2002



Using GENTRAN:Server Set Up Directories Dialog Box 2 - 33
GENTRAN:Server
for UNIX

This illustration shows the Set Up Directories dialog box for GENTRAN:Server for 
UNIX. Note that the Host directories are not available for editing. Your system 
administrator sets these during installation.

Fields and
functions

This table lists the fields of the UNIX Set Up Directories dialog box and their 
functions.

Field Function

Standards Stores a list of available standards. This directory is 
located on the server.

Note
If you have Visual Mapper capabilities, then this 
directory also stores the actual standards.

Implementation Guide Stores implementation guides (.igs). This directory is 
located on the server.

Note
The Implementation Guide directory is grayed 
out if the Visual Mapper is not installed on your 
computer system.

File Definitions/Apps Stores file definitions (DDFs). This directory is located 
on the server.

Note
If you have Visual Mapper capabilities, then this 
directory also stores the application description 
files.

(Continued on next page)
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Maps Stores map files and translation objects. This directory 
is located on the server.

Trading Partner 
Records

Stores Trading Partnership files. This directory is 
located on the server.

EDI Status Audit Stores the status audit files that GENTRAN:Server 
generates. This directory is located on the server.

EDI History Audit Stores the history audit files that GENTRAN:Server 
generates. This directory is located on the server.

User Files Stores your user files. This directory is located on the 
server.

Text/Help Files Stores text files and the GENTRAN:Server Help files. 
This directory is located on the client.

Data Files Stores your data files. This directory is located on the 
server.

Report/Log Contains the reports and log files that 
GENTRAN:Server generates. This directory is located 
on the client.

Default Check In/Out Serves as the default working directory for files. This 
directory is located on the client.

Default TPL/TBL 
Location

Serves as the default working directory for translation 
objects (compiled maps). This directory is located on 
the client.

Local Temp Serves as the default working directory. This directory 
is located on the client.

 (Contd)
Field Function
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How to Change the Default Workstation Directories

Introduction You can change the default directories for the GENTRAN:Server files from the 
values set at installation. 

Changing
Workstation

directories

Use this procedure to change a directory path for the GENTRAN:Server 
Workstation files.

Step Action

1 Click Settings on the menu bar.

2 Click Set Up Directories on the Settings menu.

System Response
The system displays the Set Up Directories dialog box.

3 Click in the appropriate text box.

4 Delete the current path and enter the new path, or edit the path as 
appropriate.

Note
You can use the browse button to the right of the box to 
browse for the path.

5 Click OK to save your changes. 
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How to Change Client Default Directories

Introduction You can change the default directories for the GENTRAN:Server for UNIX files on 
the client from the values set at installation. You cannot change the default 
directories on the host with this procedure. 

Reference
See the chapter Environment Administration in the GENTRAN:Server for 
UNIX Maintenance and Troubleshooting Guide.

How to change a
directory path

Use this procedure to change a default directory path for files on the client.

Step Action

1 Click Settings on the menu bar.

2 Click Set Up Directories on the Settings menu.

System Response
The system displays the Set Up Directories dialog box, 
showing the default directories for each type of file on the 
client. The directories on the server are not active.

3 Click in the appropriate text box.
(Continued on next page)
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4 Delete the current path and enter the new path, or edit the path.

Note
You can use the browse button to the right of the box to 
browse for the path.

5 Click OK to save your changes.

 (Contd)
Step Action
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Overview 0

Introduction

In this chapter This chapter contains information about:
◗ working in Workstation
◗ working in UNIX
◗ accessing and returning files

Key terms This table describes the key terms used in this chapter.

Term Description

check in The act of returning a copy of a file from your 
working directory to the master directory, 
making it available to other users.

check out The act of copying a file from the master 
directory to your working directory, making the 
file unavailable to other users.

lock The act of making a file unavailable to other 
users. A file is locked once it is checked out.

unlock The act of making a file available to other 
users. A file is unlocked once it is checked in.
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Working in Workstation

Introduction GENTRAN:Server Workstation uses numerous data files such as maps, 
translation objects (TPL files), file definitions,  and Trading Partnership records.

This section explains how to work with files in GENTRAN:Server Workstation and 
GENTRAN:Server for UNIX.

Master directory GENTRAN:Server Workstation stores the master files (maps, translation objects, 
file definitions,  etc.) on the PC in the master directory specified for the file type. 
You specify the master directories in the Set Up Directories dialog box, which is 
available from the main GENTRAN:Server window under the Settings menu.

File checkout When you want to edit a master file, you must check it out. When you check out  
a map file to edit it, GENTRAN:Server Workstation moves a copy of the file to the 
working directory and retains the original file in the master directory.

Working
directory

GENTRAN:Server Workstation stores your working files (copies of checked out 
maps, and file definitions) in the working directory on the PC. This enables you to 
modify a checked-out map without affecting the original file. You specify the 
working directories in the Set Up Directories dialog box, which is available from 
the GENTRAN:Server Settings menu.

Map check in When you check in a map file, GENTRAN:Server Workstation transfers a copy of 
the file from your working directory to the master directory. If the map file is one 
that you checked out, Workstation replaces the map in the master directory with 
the working copy. The working copy becomes the new master file for the map. 
GENTRAN:Server lets you to choose to keep or remove the copy of the file in 
your working directory.
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Working in GENTRAN:Server for UNIX

Background GENTRAN:Server uses numerous data files such as maps, translation objects 
(TPL files), file definitions,  and Trading Partnership records. GENTRAN:Server 
for UNIX installations control access to data files through environments, master 
files and working files, and through checking out and checking in master files.

Access rights GENTRAN:Server for UNIX provides a security utility. A system administrator 
uses this utility to assign each user the appropriate access rights for each of the 
GENTRAN:Server installations (environments). Within each installation, the 
system administrator can assign different levels of access to a user for each of the 
following functional areas:
◗ Editing maps and file definitions
◗ Editing archived files 
◗ Editing Trading Partnership records and related files (contact records, 

organization records, TRADACOMS supplemental files, and category 
records)

◗ Running the translator
◗ Using the Run Program tool.

This table shows the different levels of access that can be assigned to a function.

Master files Each installation contains master files.

A master file is the original, source version available to all users for viewing, and 
to one user at a time for editing.

(Continued on next page)

Access Type Permissions

Full View, copy, rename, load, unload, and edit files

View View, copy, rename, load, and unload files, but not to edit 
them

No Access None
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Working files When you check out a master file to view or edit, GENTRAN:Server copies the file 
and transfers the working copy from the Host to your client�s check out (working 
files) directory.

You can check out a file to any directory on your client, but the default directory is 
the one specified in the Set Up Directories dialog box.

File checkout When you want to access a master file to edit, you must check it out. When you 
check out a file to edit, the system locks the file so that other users cannot modify 
it while you have it checked out. 

Other users with proper permissions still can view the master file or use it in a 
translation even while you are editing your working copy of the master file. 

Note 
Within the file directories, an asterisk precedes the name of any file that is 
currently checked out.

(Continued on next page)
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Checking in Before any other user can edit a file that you have checked out, you must check 
the file in.

When you check in a file, GENTRAN:Server transfers a copy of the file from your 
client PC to the user directory on the Host. When the transfer is complete, 
GENTRAN:Server:
◗ copies the file from the Host user directory to the Host master directory
◗ removes the copy from the Host user directory.

When you check in a file, GENTRAN:Server lets you choose to keep or remove 
the copy of the file on your PC. 

(Continued on next page)
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Illustration This illustration shows how file access can be controlled under GENTRAN:Server 
for UNIX. 

Environment

Master
Files

Client PCs

User A

User B

Map1 checked out

Map1 view only

Server

*Map1
*Map2

Map2 view only

Map2 checked out

Map3

Working
Directory

Working
Directory

User

Master
Directory

Directory
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Dialog Boxes 0

Select Map and File Definitions Files to Check out 
Dialog Box

Introduction This topic describes the following dialog boxes:

◗ Select Map Files to Check out
◗ Select File Definition Files to Check out

Purpose The Select <filename> to Check out dialog box is used to move a copy of a file 
from the master directory to a working directory on the PC. Maps, and their 
associated TPL files, and file definitions files can be checked out.

Example check
out dialog box

The same dialog box format is used to check out file definition files.

This illustration shows the Select Map Files to Check out dialog box.

Note
If your GENTRAN:Server software is configured with Visual Mapper capabilities, 
then the dialog box will list maps created in both the Application Integration 
Mapper and the Visual Mapper with the extensions .map and .vmp respectively.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Map Files to Check Out and Select File 
Definition Files to Check out dialog box and their functions.

Field Function

 �files from Displays the name of the master directory.

The list below the name displays the names of the files 
in the master directory. An asterisk next to a name 
indicates that the file is currently checked out.

Check out <filename> 
files to

Displays the name of the default working directory on 
your PC. This is the directory to which 
GENTRAN:Server copies the file.

The list below the directory name displays the names 
of the working files in the working directory.

Note
You can use the browse button to select a different 
directory.

Add Adds the name of the selected file to the list of files in 
the working directory.

Remove Removes the name of the file from the working 
directory check out list.

Add All Adds the names of all the files in the master directory 
to the working directory.

Remove All Removes the names of all the files from the working 
directory check out list.

Edit Mode Checks out the files so that you can edit them. Copies 
the files that you added to the Check out <filename> 
files to list and moves the copies into the working 
directory. 

View Mode Checks out the files so that you can view them. Copies 
the files that you added to the Check out <filename> 
files to list and moves the copies into the working 
directory.

Note
This button is not available in GENTRAN:Server 
Workstation.
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Select Map Files to Check in Dialog Box

Introduction This topic describes the Select Map Files to Check in dialog box.

Purpose The Select Map Files to Check in dialog box is used to move the saved working 
file from your working directory to the master directory. The system replaces the 
master file with the map you check in. The following files can be checked in:
◗ map files 
◗ associated TPL  files

Example check
in dialog box

This illustration shows the Select Map Files to Check in dialog box.

Note
If your GENTRAN:Server software is configured with Visual Mapper capabilities, 
then the dialog box will list maps created in both the Application Integration 
Mapper and the Visual Mapper with the extensions .map and .vmp respectively.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Map Files to Check in dialog box and their 
functions.

Field Function

Map files from Displays the name of the working directory on your PC.

The list below the name displays the names of the 
maps in the working directory.

Note
You can use the browse button to select a different 
directory.

Check in Map files to Displays the name of the master directory for maps on 
your PC. This is the directory to which 
GENTRAN:Server copies the map file.

The list below the directory name displays the names 
of the maps in the master directory.

Add Adds the name of the selected map to the list of maps 
in the master directory.

Remove Removes the name of the map from the master 
directory check in list.

Add All Adds the names of all the maps in the working 
directory to the master directory.

Remove All Removes the names of all the maps from the master 
directory check in list.

Next Flags the maps to be checked in and displays the 
Select TBL/TPL Files to Check In dialog box. 

Close Closes this dialog box without saving your changes.
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Select TBL/TPL Files to Check In Dialog Box

Introduction The Select TBL/TPL Files to Check In dialog box is used to select the translation 
objects (compiled maps)  you want to check in.

Illustration This illustration shows the Select TBL/TPL Files to Check In dialog box.

Note
If your GENTRAN:Server software is configured with Visual Mapper capabilities, 
then the dialog box will list maps and associated files created in both the 
Application Integration Mapper and the Visual Mapper with the extensions .map 
(TPL) and .vmp (TBL) respectively.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select TBL/TPL to Check In dialog box and their 
functions.

Field Function

List of Map files to 
check in from 
directory

Displays the name of the working directory on your PC.

The list below the name displays the names of the 
maps you are checking in.

List of associated 
TBL/TPL files to 
check in with

Displays the names of the translation objects 
associated with the maps you are checking in. 

Back Returns to the Select Maps to Check In dialog box.

Finish Saves your changes and checks in the maps and 
translation objects you selected.

Close Cancels your changes and closes the dialog box.
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Select File Definition to Check in Dialog Box

Introduction The Select File Definition Files to Check in dialog box is used to move a working 
copy of a file definition file (DDF) from your working directory to the master 
directory for file definitions.

Illustration This illustration shows the Select File Definition Files to Check in dialog box.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select File Definitions to Check in dialog box and 
their functions.

Field Function

File Definition files 
from

Displays the name of the working directory.

The list below the name displays the names of the file 
definition files in the working directory. An asterisk next 
to a name indicates that the file is currently checked 
out.

Note
You can use the browse button to select a different 
directory.

Check in File 
Definition files to

Displays the name of the master directory for file 
definition files. This is the directory to which 
GENTRAN:Server copies the file.

The list below the directory name displays the names 
of the file definition files in the master directory.

Add Adds the name of the selected file definition file to the 
list of file definition files in the master directory.

Remove Removes the name of the file definition file from the 
master directory check in list.

Add All Adds the names of all the file definition files in the 
working directory to the master directory.

Remove All Removes the names of all the file definition files from 
the master directory check in list.

Check in and Remove Saves your changes, starts moving the file definition 
files, and deletes the working copies from the working 
directory.

Check in and not 
Remove

Saves your changes, starts moving the file definition 
files, and retains the working copies in the working 
directory.

Cancel Cancels your changes and closes the dialog box.
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Select Map and File Definition Files to Unlock Dialog 
Box 

Introduction This topic describes the following dialog boxes:

◗ Select Map Files to Unlock
◗ Select File Definition Files to Unlock

Purpose The unlock dialog box is used to remove the lock from the master file when you 
do not want to save changes to a file in your working directory. The following files 
can be unlocked:

◗ map files
◗ file definitions files

Example unlock
dialog box

The same dialog box format is used to unlock file definition files.

This illustration shows the Select Map Files to Unlock dialog box.

Note
If your GENTRAN:Server software is configured with Visual Mapper capabilities, 
then the dialog box will list maps created in both the Application Integration 
Mapper and the Visual Mapper with the extensions .map and .vmp respectively.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Map Files to Unlock dialog box and their 
functions.

Field Function

�files from Displays the name of the working directory.

The list below the name displays the names of the files 
in the working directory. An asterisk next to a name 
indicates that the file is currently checked out.

Notes
You can use the browse button to select a different 
directory.

Selected <filename> 
files to unlock in

Displays the name of the master directory for the files. 
This is the directory to which GENTRAN:Server copies 
the file.

The list below the directory name displays the names 
of the files in the master directory.

Add Adds the name of the selected file to the list of files in 
the master directory.

Remove Removes the name of the file from the master directory 
unlock list.

Add All Adds the names of all the files in the working directory 
to the master directory.

Remove All Removes the names of all the files from the master 
directory unlock list.

Unlock Unlocks the file or files you have selected

Cancel Cancels your changes and closes the dialog box.
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Procedures 0

How to Check Out and View Maps and File Definitions

Introduction This topic explains how to check out a file. 

What happens
when you check

out a file in
Workstation

When you check out a file in GENTRAN:Server Workstation, GENTRAN:Server 
copies the file from the master directory to the working directory on the PC.

What happens
when you check
out a file in UNIX

When you check out a file, GENTRAN:Server transfers a copy of the file from the 
Host to the client PC�s working directory. If you have Full permission, 
GENTRAN:Server locks the file on the host so that other uses cannot edit it. If you 
have View privileges, GENTRAN:Server does not lock the file.

You can check out a file to any directory. The default directory is the one specified 
in the Setup Directories dialog box.

If GENTRAN:Server locks the file when you check it out, other users cannot check 
it out to edit it. You must check in the file to release the lock so that another user 
can access it.

(Continued on next page)
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Checking out a
map or file

definitionin
Workstation

Use this procedure to check out a map, or a file definition  file in Workstation.

Step Action

1 Select Check Out from the GENTRAN:Server Main File menu and 
click the type of file you want to check out.
◗ Map
◗ File Definition File

System Response
GENTRAN:Server displays the Select <filename> files to Check 
out dialog box.

Notes
An asterisk next to a file name indicates that the file is already 
checked out.

The View Mode button is available only in the client/server version 
Select Map Files to Check out  dialog box.

2 Check the name of the default directory to which the system will 
copy checked out files. Do you want to check out files to a different 
directory?

◗ If YES, click the directory button and browse to the directory; 
continue with the next step.

◗ If NO, continue with the next step.
(Continued on next page)
GENTRAN:Server Getting Started Guide � February 2002



How to Check Out and View Maps and File Definitions Working with Application Integration3 - 20
(Continued on next page)

3 Use this table to determine your next step.

IF you want to check out� THEN�

a single file Select the file you want to check 
out from the list in the left pane 
and click Add.

Repeat this step for each 
additional file you want to check 
out.

4 all the available files Click Add All.

5 Click Edit Mode.

System Response
GENTRAN:Server displays the Check-out <filename> File Status 
dialog box.

6 Do you want to print the status report?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
Step Action
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Checking out
and viewing

maps in UNIX

Use this procedure to check out a map. 

���� �����	

1 Open the GENTRAN:Server Main window.

2 Select Check Out from the File menu and then click Map.

System Response
The system displays the Select Map Files to Check Out dialog box.

Note
An asterisk preceding a file name means that the file is checked 
out. Even if you have Full access, you can only open the file for 
viewing.

3 Use this table to determine your next step.

IF you want to check out � THEN�

a map Select the map you want to check 
out from the list and click Add.

Repeat this step for each 
additional map you want to check 
out.

all the available maps Click Add All.
(Continued on next page)
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(Continued on next page)

4 Do you want to edit the files you are checking out?
◗ If YES, click Edit Mode. (This locks the master files.)
◗ If NO, click View Mode.

System Response
GENTRAN:Server displays the Checkout Files Status dialog box. 
This dialog box lists the files to be checked out and the status of the 
process.

5 Do you want to print the information displayed on the Checkout 
Files Status dialog box?

◗ If YES, click Print.
◗ If NO, click Close.


���	�
�
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Checking out a
file definition in

UNIX

Use this procedure to check out a file definition file. 

���� �����	

1 Open the GENTRAN:Server Main window.

2 Select Check out from the File menu and then click File Definition.

System Response
The system displays the Select File Definition Files to Check out 
dialog box.

Note
An asterisk preceding a file name means the file is checked out.

3 Use the following table to determine your next step.

IF you want to check out� THEN�

a single file definition  file Select the file definition  file you 
want to check out from the left pane 
and then click Add.

Repeat this step for each additional 
file you want to check out.

all the available file definition  
files

Click Add All.

4 Do you want to edit the files you are checking out?
◗ If YES, click Edit Mode to move a copy of the file to your 

working directory (This locks the master files).
◗ If NO, click View Mode.
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How to Save Changes to Working Files

Introduction If a an Application Integration Mapper map file is open, you can save changes on 
the PC:
◗ To the open file
◗ To the working copy of a map (but not to the original map)

Note
You can also save the map files by using a new file name.

Reference
To replace an original map with a working copy of the map that you have modified, 
see How to Check In Maps and Translation Objects  in this chapter.

WARNING
If you are using both the Application Integration Mapper and the 
Visual Mapper, you must be careful NOT to overwrite your .vmp map. 
If the master directory contains a map with the same name as your 
working map, then you must use a different name for your working 
map. This prevents the .map file from overwriting the .vmp file. 
For example, if you are creating a new map in the Application 
Integration Mapper using the XXX.vmp as a guide, then save the new 
map using the file name XXY.map or XXXa.map.
GENTRAN:Server does not recognize map extensions. When you 
check in a working map to the master directory, it overwrites any 
existing map file that has the same file name, regardless of the 
extension.

Saving changes
to an open file

Use this procedure to save changes to an open file.

Procedure 
Click Save on the File menu. 

System Response
GENTRAN:Server updates the file.

(Continued on next page)
GENTRAN:Server Getting Started Guide � February 2002



Working with Application Integration How to Save Changes to Working Files 3 - 25
Saving to a new
file name

Use this procedure to save an open working map file to a new file name in the 
working directory.

CAUTION
You cannot use this procedure to save a working map file to the 
master directory.

Step Action

1 Click Save As on the File menu. 

System Response
GENTRAN:Server displays the Save As dialog box.

2 Type the new file name for the copy of the map.

Note
You cannot save a map file to another directory, but you can save it 
under a new file name.

Reference
See How to Check In Maps and Translation Objects in this chapter 
to replace a master map file with a modified working copy.

3 Click OK.

System Response
GENTRAN:Server saves a copy of the map under the new name.
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How to Unlock Master Files and Delete Working Copies

Introduction If you do not want to save changes to a file in your working directory, you can use 
the GENTRAN:Server Unlock function to remove the lock from the master file and 
delete the working copy of the file. This procedure explains how to use the Unlock 
function.

CAUTION
When you unlock a master file, you lose all changes you made to the 
working file. Use this procedure only if you want to delete the 
working file.

Procedure Use this procedure to unlock a master file and delete a working file.

Step Action

1 Select Unlock from the File menu and click the type of file you want 
to unlock:

◗ Map
◗ File Definition File

System Response
GENTRAN:Server displays the Select <filename> Files to Unlock 
dialog box.

(Continued on next page)
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2 Use this table to determine your next step.

IF you want to unlock� THEN�

a single file Select the file you want to remove 
from the list of available files in the left 
box and click Add.

System Response
GENTRAN:Server moves the selected 
file to the selected files to unlock list.

all the available files Click Add All.

System Response
GENTRAN:Server moves all the files 
to the selected files to unlock list.

.

3 Click Unlock.

System Response
GENTRAN:Server displays this dialog box.

(Continued on next page)

 (Contd)
Step Action
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4 Do you want to continue?
◗ If YES, click Yes.
◗ If NO, click No.

System Response
If you clicked Yes, GENTRAN:Server displays the Unlock 
<filename> File Status dialog box.

5 Do you want to print the status report?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
Step Action
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How to Copy a Translation Object to the Host User 
Directory

Introduction After you compile a new map to create translation object, you can copy the 
translation object to the Host user directory for testing with the translator.

Copying a
translation

object to the
host user
directory

Use this procedure to copy a translation object to the Host user directory.

Step Action

1 Open the GENTRAN:Server Main Window.

2 Select Copy .TBL/.TPL file to User Directory....

System Response
GENTRAN:Server displays a dialog box for you to select the file 
you want to copy.

3 Select the translation object (TPL file) and click Open.

System Response
GENTRAN:Server copies the file to the User Directory on the Host.
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How to Check In Maps and Translation Objects

Introduction This topic explains how to check in maps and the translation objects (TPL files) 
associated with them.

What happens
when you check

in a file in
Workstation

When you are satisfied that a working map and translation object  produces the 
results you expect, you check in the working file. When you check in a working 
file, the system copies the file from the working directory to the master directory, 
replacing the original file. The working file becomes the new map or translation 
object . You can choose to leave a copy of the file in the working directory or 
remove it.

What happens
when you check
in a file in UNIX

When you check in a file, GENTRAN:Server transfers a copy of the file from the 
working directory on your PC to the user directory on the Host. You can choose 
whether or not to keep or remove the copy of the file that is on your PC.

After the file has been transferred, GENTRAN:Server
◗ copies the file from the user directory to the master directory
◗ removes the copy from the user directory
◗ unlocks the master file so that others can access it.

Maps The procedure for checking in maps differs from that for checking in other files, 
because you can check in multiple maps at the same time.

You can check in a compiled working map or an uncompiled working map.
◗ If you compile a working map before you check it in, the Check In function 

moves the compiled map to the master directory.
◗ If you move an uncompiled working map, you must compile it in the master 

directory; otherwise, the translator will not recognize the changes.

(Continued on next page)
GENTRAN:Server Getting Started Guide � February 2002



Working with Application Integration How to Check In Maps and Translation Objects 3 - 31
Checking in
maps and

translation
objects  in

Workstation

Use this procedure to check in a map and translation object.

Step Action

1 Select Check In from the GENTRAN:Server Main File menu and 
click Map.

System Response
GENTRAN:Server displays the Select Map Files to Check in dialog 
box.

WARNING
If you are using both the Application Integration Mapper 
and the Visual Mapper, you must be careful NOT to 
overwrite your .vmp map. If the master directory 
contains a map with the same name as your working 
map, then you must use a different name for your 
working map. This prevents the .map file from 
overwriting the .vmp file. 
For example, if you are creating a new map in the 
Application Integration Mapper using the XXX.vmp as a 
guide, then save the new map using the file name 
XXY.map or XXXa.map.
GENTRAN:Server does not recognize map extensions. 
When you check in a working map to the master 
directory, it overwrites any existing map file that has the 
same file name, regardless of the extension.

(Continued on next page)
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2 Use this table to determine your next step.

IF you want to check in� THEN�

a single map Select the map you want to 
check in from the list in the left 
pane and click Add.

Repeat this step for each 
additional map you want to 
check in.

 all the available maps Click Add All.

3 Click Next.

System Response
GENTRAN:Server searches for the associated translation object 
files in the default Table Location directory and displays the results 
in the Select TBL/TPL Files to Check In dialog box.

4 Do you want GENTRAN:Server to search for the translation object 
in a different directory?

◗ If YES, click the browse button next to specify the directory; 
continue with next step.

◗ If NO, continue with Step 5.
(Continued on next page)
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(Continued on next page)

5 Do you want to check in the translation object associated with the 
map you are checking in?
◗ If YES, make sure that the check box next to the translation 

object is checked and then click Finish.
◗ If NO, click the check box to remove the check mark and then 

click Finish.

System Response
GENTRAN:Server displays this dialog box.

6 Do you want to remove the copies of the working files from the 
working directory after the files are checked in?

◗ If YES, click the Yes button.
◗ If NO, click the No button.

System Response
The system displays the Check-in Map and TBL/TPL File Status 
dialog box.

7 Do you want to print the status report?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
Step Action
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Checking in
maps and

translation
objects  in UNIX

Use this procedure to replace a map in the master directory with a modified 
working map.

���� �����	

1 Click Check In from the Main File menu and select Map as the 
type of file to check in.

System Response
The system displays the Select Map Files to Check In dialog box. 

Note
The list on the left shows only the maps that are in your working 
directory.

WARNING
If you are using both the Application Integration Mapper 
and the Visual Mapper, you must be careful NOT to 
overwrite your .vmp map. If the master directory 
contains a map with the same name as your working 
map, then you must use a different name for your 
working map. This prevents the .map file from 
overwriting the .vmp file. 
For example, if you are creating a new map in the 
Application Integration Mapper using the XXX.vmp as a 
guide, then save the new map using the file name 
XXY.map or XXXa.map.
GENTRAN:Server does not recognize map extensions. 
When you check in a working map to the master 
directory, it overwrites any existing map file that has the 
same file name, regardless of the extension.

(Continued on next page)
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2 Use this table to determine your next step.

IF you want to� THEN�

Check in a map Select the map you want to 
check in from the list and click 
Add.

Repeat this step for each 
additional map you want to 
check in.

Check in all the available maps Click Add All.

3 Click Next.

System Response
GENTRAN:Server displays the Select TBL/TPL Files to Check In 
dialog box.

4 Do you want to check in the translation objects (compiled maps) 
associated with the maps you selected?

◗ If YES, make sure that the check box next to the name of the 
translation object is checked.

◗ If NO, remove the check box from the translation objects that 
you do not want to check in.

(Continued on next page)
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5 Click Finish.

System Response
The system moves the selected files from the working directory on 
the client to the user directory on the Host. After the files have been 
transferred successfully, the system moves them from the user 
directory to the master directory and unlocks the master files.
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How to Check In File Definitions 

Introduction When you are satisfied with a file definition  file, you check in the working file. 
When you check in a working file, the system copies the file from the working 
directory to the master directory, replacing the original file. The working file 
becomes the new file definition . You can choose to leave a copy of the file in the 
working directory or remove it.

Checking in a file
definition in

Workstation and
UNIX

Use this procedure to check in a file definition file.

Step Action

1 Select Check In from the GENTRAN:Server Main File menu 
and click either File Definition FileSystem Response
GENTRAN:Server displays the Select File Definition File  to Check 
in dialog box.

(Continued on next page)
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2 Use this table to determine your next step.

IF you want to check in� THEN�

a single file definition  file Select the file definition  file you 
want to check in from the list in 
the left pane and click Add.

Repeat this step for each 
additional file you want to check 
in.

all the available file definition  
files

Click Add All.

3 Use this table to determine your next step.

IF you want to� THEN click�

Remove the working files from 
the working directory after they 
are checked in

Check in and Remove

Leave the working files in the 
working directory after they are 
checked in

Check in and not Remove

System Response
GENTRAN:Server displays the Check-in File Definition File Status 
dialog box.

(Continued on next page)

 (Contd)
Step Action
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4 Do you want to print the status report?
◗ If YES, click Print.
◗ If NO, click Close.

 (Contd)
Step Action
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Overview 0

Working in Workstation

Introduction GENTRAN:Server Workstation uses numerous data files such as maps,  
compiled maps (TBL), implementation guides, application descriptions, and 
Trading Partnership records.

Master directory GENTRAN:Server Workstation stores the master files (maps,  compiled maps, 
implementation guides, application descriptions, etc.) on the PC in the master 
directory specified for the file type. You specify the master directories in the Set 
Up Directories dialog box, which is available from the main GENTRAN:Server 
window under the Settings menu.

File checkout When you want to edit a master file, you must check it out. When you  check out a 
map file to edit it, GENTRAN:Server Workstation moves a copy of the file to the 
working directory and retains the original file in the master directory.

Working
directory

GENTRAN:Server Workstation stores your working files (copies of checked out 
maps, implementation guides, and application descriptions) in the working 
directory on the PC. This enables you to modify a checked-out map without 
affecting the original file. You specify the working directories in the Set Up 
Directories dialog box, which is available from the GENTRAN:Server Settings 
menu.

Map check in When you check in a map file, GENTRAN:Server Workstation transfers a copy of 
the file from your working directory to the master directory. If the map file is one 
that you checked out, Workstation replaces the map in the master directory with 
the working copy. The working copy becomes the new master file for the map. 
GENTRAN:Server lets you to choose to keep or remove the copy of the file in 
your working directory.
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Working in GENTRAN:Server for UNIX

Background GENTRAN:Server uses numerous data files such as maps,  compiled maps 
(TBL), implementation guides, application descriptions, and Trading Partnership 
records. GENTRAN:Server for UNIX installations control access to data files 
through environments, master files and working files, and through checking out 
and checking in master files.

Access rights GENTRAN:Server for UNIX provides a security utility. A system administrator 
uses this utility to assign each user the appropriate access rights for each of the 
GENTRAN:Server installations (environments). Within each installation, the 
system administrator can assign different levels of access to a user for each of the 
following functional areas:
◗ Editing maps and application descriptions and implementation guides
◗ Editing archived files 
◗ Editing Trading Partnership records and related files (contact records, 

organization records, TRADACOMS supplemental files, and category 
records)

◗ Running the translator
◗ Using the Run Program tool.

This table shows the different levels of access that can be assigned to a function.

Master files Each installation contains master files.

A master file is the original, source version available to all users for viewing, and 
to one user at a time for editing.

(Continued on next page)

Access Type Permissions

Full View, copy, rename, load, unload, and edit files

View View, copy, rename, load, and unload files, but not to edit 
them

No Access None
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Working files When you check out a master file to view or edit, GENTRAN:Server copies the file 
and transfers the working copy from the Host to your client�s check out (working 
files) directory.

You can check out a file to any directory on your client, but the default directory is 
the one specified in the Set Up Directories dialog box.

File checkout When you want to access a master file to edit, you must check it out. When you 
check out a file to edit, the system locks the file so that other users cannot modify 
it while you have it checked out. 

Other users with proper permissions still can view the master file or use it in a 
translation even while you are editing your working copy of the master file. 

Note 
Within the file directories, an asterisk precedes the name of any file that is 
currently checked out.

(Continued on next page)
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Checking in Before any other user can edit a file that you have checked out, you must check 
the file in.

When you check in a file, GENTRAN:Server transfers a copy of the file from your 
client PC to the user directory on the Host. When the transfer is complete, 
GENTRAN:Server:
◗ copies the file from the Host user directory to the Host master directory
◗ removes the copy from the Host user directory.

When you check in a file, GENTRAN:Server lets you choose to keep or remove 
the copy of the file on your PC. 

(Continued on next page)
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Illustration This illustration shows how file access can be controlled under GENTRAN:Server 
for UNIX. 

Environment

Master
Files

Client PCs

User A

User B

Map1 checked out

Map1 view only

Server

*Map1
*Map2

Map2 view only

Map2 checked out

Map3

Working
Directory

Working
Directory

User

Master
Directory

Directory
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Dialog Boxes 0

Select Map Files to Check Out Dialog Box

Introduction The Select Map Files to Check Out dialog box is used to move a copy of a map 
from the master directory to a working directory on the PC. It also moves 
associated TBL/TPL files

Illustration This illustration shows the Select Map Files to Check Out dialog box.

Note
If your GENTRAN:Server software is configured with Visual Mapper capabilities, 
then the Select Map Files to Check out dialog box lists the maps created in both 
the Application Integration Mapper and the Visual Mapper with the extensions 
.map and .vmp respectively.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Map Files to Check Out dialog box and their 
functions.

Field Function

Map files from Displays the name of the master directory.

The list below the name displays the names of the 
maps in the master directory. An asterisk next to a 
name indicates that the map is currently checked out.

Check out Map files to Displays the name of the default working directory on 
your PC. This is the directory to which 
GENTRAN:Server copies the map file.

The list below the directory name displays the names 
of the working maps in the working directory.

Note
You can use the browse button to select a different 
directory.

Add Adds the name of the selected map to the list of maps 
in the working directory.

Remove Removes the name of the map from the working 
directory check out list.

Add All Adds the names of all the maps in the master directory 
to the working directory.

Remove All Removes the names of all the maps from the working 
directory check out list.

Edit Mode Checks out the maps so that you can edit them. 
Copies the maps that you added to the Check out 
Map files to list and moves the copies into the working 
directory. 

View Mode Checks out the maps so that you can view them. 
Copies the maps that you added to the Check out 
Map files to list and moves the copies into the working 
directory.

Note
View Mode is available on the client/server Select Map 
Files to Check out dialog box.
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Select IG/Application Description Files to Check out 
Dialog Box

Introduction This topic describes the following dialog boxes:

◗ Select Implementation Guide Files to Check out
◗ Select Application Description Files to Check out

Purpose The check out dialog box is used to move a copy of a file from the master 
directory to a working directory on the PC. The following files can be checked out:

◗ application descriptions files
◗ implementation guides files

Example check
out dialog box

The same dialog box format is used to check out application description files.

This illustration shows the Select Implementation Guide Files to Check out dialog 
box.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Implementation Guide Files to Check Out 
and Select Application Description Files dialog box and their functions.

Field Function

 �files from Displays the name of the master directory.

The list below the name displays the names of the files 
in the master directory. An asterisk next to a name 
indicates that the file is currently checked out.

Check out <filename> 
files to

Displays the name of the default working directory on 
your PC. This is the directory to which 
GENTRAN:Server copies the file.

The list below the directory name displays the names 
of the working files in the working directory.

Note
You can use the browse button to select a different 
directory.

Add Adds the name of the selected file to the list of files in 
the working directory.

Remove Removes the name of the file from the working 
directory check out list.

Add All Adds the names of all the files in the master directory 
to the working directory.

Remove All Removes the names of all the files from the working 
directory check out list.

Edit Mode Checks out the files so that you can edit them. Copies 
the files that you added to the Check out <filename> 
files to list and moves the copies into the working 
directory. 

View Mode Checks out the map files (file definition files so that you 
can view them. Copies the maps that you added to the 
Check out <filename> files to list and moves the 
copies into the working directory.

Note
View Mode is available on Select Application 
Description File to Check out dialog box.
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Select Generic Synonym/Thesaurus File to Check out 
Dialog Box

Introduction This topic describes the following dialog boxes:

◗ Select Generic Synonym File to Check out
◗ Select Thesaurus File to Check out

Purpose The check out dialog boxes are used to move a copy of a generic synonym list or 
thesaurus list from the master directory to a working directory on the PC. 

Example check
out dialog box

The same dialog box format is used to check out a thesaurus list.

This illustration shows the Select Generic Synonym File to Check out dialog box.

Fields and
functions

This table lists the fields of the Select Generic Synonym File to Check out and the 
Select Thesaurus File to Check out dialog box and their functions.

Field Function

� file from directory Displays the name of the master directory.

To directory Displays the name of the default working directory on 
your PC. This is the directory to which 
GENTRAN:Server copies the file.

Note
You can use the browse button to select a different 
directory.

(Continued on next page)
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Edit Mode Checks out the file so that you can edit it. Copies the 
file that you selected and moves the copy into the 
working directory. 

View Mode Checks out the file so that you can view them. Copies 
the file that you selected and moves the copy into the 
working directory.

 (Contd)
Field Function
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Select Map Files to Check in Dialog Box

Introduction This topic describes the Select Map Files to Check in dialog box.

Purpose The Select Map Files to Check in dialog box is used to move the saved working 
file from your working directory to the master directory. The system replaces the 
master file with the map you check in. The following files can be checked in:
◗ map files 
◗ associated  TBL files

Example check
in dialog box

This illustration shows the Select Map Files to Check in dialog box.

Note
If your GENTRAN:Server software is configured with Visual Mapper capabilities, 
then the dialog box will list maps created in both the Application Integration 
Mapper and the Visual Mapper with the extensions .map and .vmp respectively.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Map Files to Check in dialog box and their 
functions.

Field Function

Map files from Displays the name of the working directory on your PC.

The list below the name displays the names of the 
maps in the working directory.

Note
You can use the browse button to select a different 
directory.

Check in Map files to Displays the name of the master directory for maps on 
your PC. This is the directory to which 
GENTRAN:Server copies the map file.

The list below the directory name displays the names 
of the maps in the master directory.

Add Adds the name of the selected map to the list of maps 
in the master directory.

Remove Removes the name of the map from the master 
directory check in list.

Add All Adds the names of all the maps in the working 
directory to the master directory.

Remove All Removes the names of all the maps from the master 
directory check in list.

Next Flags the maps to be checked in and displays the 
Select TBL/TPL Files to Check In dialog box. 

Close Closes this dialog box without saving your changes.
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Select TBL/TPL Files to Check In Dialog Box

Introduction The Select TBL/TPL Files to Check In dialog box is used to select the  compiled 
maps you want to check in.

Illustration This illustration shows the Select TBL/TPL Files to Check In dialog box.

Note
If your GENTRAN:Server software is configured with Visual Mapper capabilities, 
then the dialog box will list maps and associated files created in both the 
Application Integration Mapper and the Visual Mapper with the extensions .map 
(TPL) and .vmp (TBL) respectively.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select TBL/TPL to Check In dialog box and their 
functions.

Field Function

List of Map files to 
check in from 
directory

Displays the name of the working directory on your PC.

The list below the name displays the names of the 
maps you are checking in.

List of associated 
TBL/TPL files to 
check in with

Displays the names of the translation objects 
associated with the maps you are checking in. 

Back Returns to the Select Maps to Check In dialog box.

Finish Saves your changes and checks in the maps and 
translation objects you selected.

Close Cancels your changes and closes the dialog box.
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Select IG/Application Description Files to Check in 
Dialog Box

Introduction This topic describes the following dialog boxes:

◗ Select Implementation Guide Files to Check in
◗ Select Application Description Files to Check in

Purpose The check in dialog box is used to move the saved working copy of a file from 
your working directory to the master directory. The system replaces the master file 
with the file you check in. The following files can be checked in:

◗ implementation guides files
◗ application descriptions files

Example check
in dialog box

The same dialog box format is used to check in application description files.

This illustration shows the Select Implementation Guide Files to Check in dialog 
box.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Implementation Guide Files to Check in and 
Select Application Description Files to Check in dialog box and their functions.

Field Function

� files from Displays the name of the working directory.

The list below the name displays the names of the files 
in the working directory. An asterisk next to a name 
indicates that the file is currently checked out.

Note
You can use the browse button to select a different 
directory.

Check in <filename> 
files to

Displays the name of the master directory for files. This 
is the directory to which GENTRAN:Server copies the 
file.

The list below the directory name displays the names 
of the files in the master directory.

Add Adds the name of the selected file to the list of file 
definition files in the master directory.

Remove Removes the name of the file from the master directory 
check in list.

Add All Adds the names of all the files in the working directory 
to the master directory.

Remove All Removes the names of all the files from the master 
directory check in list. 

Check in and Remove Saves your changes, starts moving the files, and 
deletes the working copies from the working directory.

Check in and not 
Remove

Saves your changes, starts moving the files, and 
retains the working copies in the working directory.

Cancel Cancels your changes and closes the dialog box.
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Select Synonym and Thesaurus File to Check in Dialog 
Boxes

Introduction This topic describes the following dialog boxes:

◗ Select Generic Synonym File to Check in
◗ Select Thesaurus File to Check in

Purpose The check in dialog box is used to move the saved working copy of a file from 
your working directory to the master directory. The system replaces the master file 
with the file you check in. The following files can be checked in:

◗ generic synonym list
◗ thesaurus list

Example check
in dialog box

The same dialog box format is used to check in thesaurus lists.

This illustration shows the Select Generic Synonym File to Check in dialog box.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Generic Synonym File to Check in and 
Select Thesaurus File to Check in dialog box and their functions.

Field Function

Check in <filename> 
file from directory

Displays the name of the working directory.

The list below the name displays the name of the file in 
the working directory. 

Note
You can use the browse button to select a different 
directory.

To directory Displays the name of the master directory for the file. 
This is the directory to which GENTRAN:Server copies 
the file.

The list below the directory name displays the name of 
the file in the master directory.

Check in and Remove Saves your changes, starts moving the file, and 
deletes the working copy from the working directory.

Check in and not 
Remove

Saves your changes, starts moving the file, and retains 
the working copy in the working directory.

Cancel Cancels your changes and closes the dialog box.
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Select Map Files to Unlock Dialog Box 

Introduction The Select Map Files to Unlock dialog box is used to remove the lock from the 
master file when you do not want to save changes to a map file in your working 
directory. 

Purpose The unlock dialog box is used to remove the lock from the master file when you 
do not want to save changes to a map file in your working directory. 

Illustration This illustration shows the Select Map Files to Unlock dialog box dialog box.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Map Files to Unlock dialog box and their 
functions.

Field Function

Map files from Displays the name of the working directory.

The list below the name displays the names of the map 
files in the working directory. An asterisk next to a 
name indicates that the file is currently checked out.

Note
You can use the browse button to select a different 
directory.

Selected Map files to 
unlock in

Displays the name of the master directory for map files. 
This is the directory to which GENTRAN:Server copies 
the file.

The list below the directory name displays the names 
of the map files in the master directory.

Add Adds the name of the selected map files to the list of 
map files in the master directory.

Remove Removes the name of the map file from the master 
directory unlock list.

Add All Adds the names of all the map files in the working 
directory to the master directory.

Remove All Removes the names of all the map files from the 
master directory unlock list.

Unlock Unlocks the file or files you have selected

Cancel Cancels your changes and closes the dialog box.
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Select IG/Application Description Files to Unlock 
Dialog Box

Introduction This topic describes the following dialog boxes:

◗ Select Implementation Guide Files to Unlock
◗ Select Application Description Files to Unlock

Purpose The Select <filename> Files to Unlock dialog box is used to remove the lock from 
the master file when you do not want to save changes to a file in your working 
directory. The following files can be unlocked:

◗ implementation guide files
◗ application description files

Example unlock
dialog box

The same dialog box format is used to unlock application description files.

This illustration shows the Select Implementation Guide Files to Unlock dialog box 
dialog box.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Select Implementation Guide Files to Unlock 
Select Application Description Files to Unlock dialog box and their functions.

Field Function

�files from Displays the name of the working directory.

The list below the name displays the names of the files 
in the working directory. An asterisk next to a name 
indicates that the file is currently checked out.

Notes
You can use the browse button to select a different 
directory.

Selected <filename> 
files to unlock in

Displays the name of the master directory for the files. 
This is the directory to which GENTRAN:Server copies 
the file.

The list below the directory name displays the names 
of the files in the master directory.

Add Adds the name of the selected files to the list of map 
files in the master directory.

Remove Removes the name of the file from the master directory 
unlock list.

Add All Adds the names of all the files in the working directory 
to the master directory.

Remove All Removes the names of all the files from the master 
directory unlock list. 

Unlock Unlocks the file or files you have selected

Cancel Cancels your changes and closes the dialog box.
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Synonym and Thesaurus File to Unlock Dialog Boxes

Introduction This topic describes the following dialog boxes:
◗ Select Generic Synonym Files to Unlock
◗ Select Thesaurus Files to Unlock

Purpose The unlock dialog box is used to remove the lock from the master file when you do 
not want to save changes to a file in your working directory. The following files can 
be unlocked:
◗ generic synonym list
◗ thesaurus list

Example unlock
dialog box

The same dialog box format is used to unlock thesaurus lists.

This illustration shows the Select Generic Synonym Files to Unlock dialog box.

Fields and
functions

This table lists the fields of the Select Generic Synonym Files to Unlock and 
Select Thesaurus Files to Unlock dialog box and their functions.

Field Function

Unlock <filename> file 
from directory

Displays the name of the working directory.

Note
You can use the browse button to select a different 
directory.

Unlock Unlocks the file or files you have selected

Cancel Cancels your changes and closes the dialog box.
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Procedures 0

How to Check Out and View Maps and IG/Application 
Descriptions

Introduction This topic explains how to check out a file. 

What happens
when you check

out a file in
Workstation

When you check out a file in GENTRAN:Server Workstation, GENTRAN:Server 
copies the file from the master directory to the working directory on the PC.

What happens
when you check
out a file in UNIX

When you check out a file, GENTRAN:Server transfers a copy of the file from the 
Host to the client PC�s working directory. If you have Full permission, 
GENTRAN:Server locks the file on the host so that other uses cannot edit it. If you 
have View privileges, GENTRAN:Server does not lock the file.

You can check out a file to any directory. The default directory is the one specified 
in the Setup Directories dialog box.

If GENTRAN:Server locks the file when you check it out, other users cannot check 
it out to edit it. You must check in the file to release the lock so that another user 
can access it.

(Continued on next page)
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Checking out a
map, an IG, or

application
description in

Workstation

Use this procedure to check out a map, an implementation guide, an application 
description file in Workstation.

Step Action

1 Select Check Out from the GENTRAN:Server Main File menu and 
click the type of file you want to check out.
◗ Map
◗ Implementation Guide
◗ Application Description

System Response
GENTRAN:Server displays the Select <filename> files to Check 
out dialog box.

Notes
An asterisk next to a file name indicates that the file is already 
checked out.

The View Mode button is available only in the client/server version 
Select Map Files to Check out and Select Application Description 
Files dialog box.

2 Check the name of the default directory to which the system will 
copy checked out files. Do you want to check out files to a different 
directory?

◗ If YES, click the directory button and browse to the directory; 
continue with the next step.

◗ If NO, continue with the next step.
(Continued on next page)
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(Continued on next page)

3 Use this table to determine your next step.

IF you want to check out� THEN�

a single file Select the file you want to check 
out from the list in the left pane 
and click Add.

Repeat this step for each 
additional file you want to check 
out.

4 all the available files Click Add All.

5 Click Edit Mode.

System Response
GENTRAN:Server displays the Check-out <filename> File Status 
dialog box.

6 Do you want to print the status report?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
Step Action
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Checking out
and viewing

maps in UNIX

Use this procedure to check out a map. 

���� �����	

1 Open the GENTRAN:Server Main window.

2 Select Check Out from the File menu and then click Map.

System Response
The system displays the Select Map Files to Check Out dialog box.

Note
An asterisk preceding a file name means that the file is checked 
out. Even if you have Full access, you can only open the file for 
viewing.

3 Use this table to determine your next step.

IF you want to check out � THEN�

a map Select the map you want to check 
out from the list and click Add.

Repeat this step for each 
additional map you want to check 
out.

all the available maps Click Add All.
(Continued on next page)
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(Continued on next page)

4 Do you want to edit the files you are checking out?
◗ If YES, click Edit Mode. (This locks the master files.)
◗ If NO, click View Mode.

System Response
GENTRAN:Server displays the Checkout Files Status dialog box. 
This dialog box lists the files to be checked out and the status of the 
process.

5 Do you want to print the information displayed on the Checkout 
Files Status dialog box?

◗ If YES, click Print.
◗ If NO, click Close.
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Checking out an
IG or application

description in
UNIX

Use this procedure to check out an implementation guide, an application 
description file. 

���� �����	

1 Open the GENTRAN:Server Main window.

2 Select Check out from the File menu and then click 
Implementation Guide or Application Description.

System Response
The system displays the Select<filename>Files to Check out dialog 
box

Note
An asterisk preceding a file name means the file is checked out.

(Continued on next page)
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3 Use the following table to determine your next step.

IF you want to check out� THEN�

a single implementation 
guide or application 
description file 

Select the implementation guide or 
application description file you want 
to check out from the left pane and 
then click Add.

Repeat this step for each additional 
file you want to check out.

all the available 
implementation guide or 
application description files

Click Add All.

4 Do you want to edit the files you are checking out?
◗ If YES, click Edit Mode to move a copy of the file to your 

working directory (This locks the master files).
◗ If NO, click View Mode.
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How to Check out a Generic Synonym/Thesaurus List 

Introduction This topic explains how to check out generic synonym list and a thesaurus list in 
Workstation and UNIX.

Procedure Use this procedure to check out a generic synonym list or thesaurus list file in 
Workstation.

Step Action

1 Select Check Out from the GENTRAN:Server Main File menu and 
click the type of file you want to check out.
◗ Generic Synonym List
◗ Thesaurus List

System Response
GENTRAN:Server displays the Select <filename> Files to Check 
out dialog box.

Notes
An asterisk next to a file name indicates that the file is already 
checked out.

The View Mode button is available only in the client/server version 
Select Map Files to Check out and Select Application Description 
Files dialog box.

2 Check the name of the default directory to which the system will 
copy checked out files. Do you want to check out files to a different 
directory?

◗ If YES, click the directory button and browse to the directory; 
continue with the next step.

◗ If NO, continue with the next step.
(Continued on next page)
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3 Click Edit Mode.

System Response
GENTRAN:Server displays the Check-out <filename> File Status 
dialog box.

4 Do you want to print the status report?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
Step Action
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How to Save Changes to Working Files

Introduction If a Visual Mapper map file is open, you can save changes on the PC:
◗ To the open file
◗ To the working copy of a map (but not to the original map)

Note
You can also save the map files by using a new file name.

Reference
To replace an original map with a working copy of the map that you have modified, 
see  How to Check In Compiled Maps in this chapter.

WARNING
If you are using both the Application Integration Mapper and the 
Visual Mapper, you must be careful NOT to overwrite your .vmp map. 
If the master directory contains a map with the same name as your 
working map, then you must use a different name for your working 
map. This prevents the .map file from overwriting the .vmp file. 
For example, if you are creating a new map in the Application 
Integration Mapper using the XXX.vmp as a guide, then save the new 
map using the file name XXY.map or XXXa.map.
GENTRAN:Server does not recognize map extensions. When you 
check in a working map to the master directory, it overwrites any 
existing map file that has the same file name, regardless of the 
extension.

Saving changes
to an open file

Use this procedure to save changes to an open file.

Procedure 
Click Save on the File menu. 

System Response
GENTRAN:Server updates the file.

(Continued on next page)
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Saving to a new
file name

Use this procedure to save an open working map file to a new file name in the 
working directory.

CAUTION
You cannot use this procedure to save a working map file to the 
master directory.

Step Action

1 Click Save As on the File menu. 

System Response
GENTRAN:Server displays the Save As dialog box.

2 Type the new file name for the copy of the map.

Note
You cannot save a map file to another directory, but you can save it 
under a new file name.

Reference
See  How to Check In Compiled Maps in this chapter to replace a 
master map file with a modified working copy.

3 Click OK.

System Response
GENTRAN:Server saves a copy of the map under the new name.
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How to Unlock Master Files and Delete Working Copies

Introduction If you do not want to save changes to a file in your working directory, you can use 
the GENTRAN:Server Unlock function to remove the lock from the master file and 
delete the working copy of the file. This procedure explains how to use the Unlock 
function.

CAUTION
When you unlock a master file, you lose all changes you made to the 
working file. Use this procedure only if you want to delete the 
working file.

(Continued on next page)
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Procedure Use this procedure to unlock a master file and delete a working file.

Step Action

1 Select Unlock from the File menu and click the type of file you want 
to unlock:

◗ Map
◗ Implementation Guide
◗ Application Description
◗ Generic Synonym List
◗ Thesaurus List

System Response
GENTRAN:Server displays the Select <filename> Files to Unlock 
dialog box.

(Continued on next page)
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2 Use this table to determine your next step.

IF you want to unlock� THEN�

a single file Select the file you want to remove 
from the list of available files in the left 
box and click Add.

System Response
GENTRAN:Server moves the selected 
file to the selected files to unlock list.

all the available files Click Add All.

System Response
GENTRAN:Server moves all the files 
to the selected files to unlock list.

a generic synonym or 
thesaurus list

Go to Step 3.

3 Click Unlock.

System Response
GENTRAN:Server displays this dialog box.

(Continued on next page)
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4 Do you want to continue?
◗ If YES, click Yes.
◗ If NO, click No.

System Response
If you clicked Yes, GENTRAN:Server displays the Unlock 
<filename> File Status dialog box.

5 Do you want to print the status report?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
Step Action
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How to Copy a Compiled Map to the Host User 
Directory

Introduction After you compile a new map to create compiled map, you can copy the 
translation object to the Host user directory for testing with the translator.

Copying a
compiled map to

the host user
directory

Use this procedure to copy a compiled map to the Host user directory.

Step Action

1 Open the GENTRAN:Server Main Window.

2 Select Copy .TBL/.TPL file to User Directory....

System Response
GENTRAN:Server displays a dialog box for you to select the file 
you want to copy.

3 Select the compiled map (TBL file) and click Open.

System Response
GENTRAN:Server copies the file to the User Directory on the Host.
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How to Check In Compiled Maps

Introduction This topic explains how to check in maps  and the compiled maps (TBL files) 
associated with them.

What happens
when you check

in a file in
Workstation

When you are satisfied that a working map  and compiled map produces the 
results you expect, you check in the working file. When you check in a working 
file, the system copies the file from the working directory to the master directory, 
replacing the original file. The working file becomes the new map or compiled 
map. You can choose to leave a copy of the file in the working directory or remove 
it.

What happens
when you check
in a file in UNIX

When you check in a file, GENTRAN:Server transfers a copy of the file from the 
working directory on your PC to the user directory on the Host. You can choose 
whether or not to keep or remove the copy of the file that is on your PC.

After the file has been transferred, GENTRAN:Server
◗ copies the file from the user directory to the master directory
◗ removes the copy from the user directory
◗ unlocks the master file so that others can access it.

Maps The procedure for checking in maps differs from that for checking in other files, 
because you can check in multiple maps at the same time.

You can check in a compiled working map or an uncompiled working map.
◗ If you compile a working map before you check it in, the Check In function 

moves the compiled map to the master directory.
◗ If you move an uncompiled working map, you must compile it in the master 

directory; otherwise, the translator will not recognize the changes.

(Continued on next page)
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Checking in
maps and

compiled maps
in Workstation

Use this procedure to check in a map and compiled map.

Step Action

1 Select Check In from the GENTRAN:Server Main File menu and 
click Map.

System Response
GENTRAN:Server displays the Select Map Files to Check in dialog 
box.

WARNING
If you are using both the Application Integration Mapper 
and the Visual Mapper, you must be careful NOT to 
overwrite your .vmp map. If the master directory 
contains a map with the same name as your working 
map, then you must use a different name for your 
working map. This prevents the .map file from 
overwriting the .vmp file. 
For example, if you are creating a new map in the 
Application Integration Mapper using the XXX.vmp as a 
guide, then save the new map using the file name 
XXY.map or XXXa.map.
GENTRAN:Server does not recognize map extensions. 
When you check in a working map to the master 
directory, it overwrites any existing map file that has the 
same file name, regardless of the extension.

(Continued on next page)
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2 Use this table to determine your next step.

IF you want to check in� THEN�

a single map Select the map you want to 
check in from the list in the left 
pane and click Add.

Repeat this step for each 
additional map you want to 
check in.

 all the available maps Click Add All.

3 Click Next.

System Response
GENTRAN:Server searches for the associated translation object 
files in the default Table Location directory and displays the results 
in the Select TBL/TPL Files to Check In dialog box.

4 Do you want GENTRAN:Server to search for the translation object 
in a different directory?

◗ If YES, click the browse button next to specify the directory; 
continue with next step.

◗ If NO, continue with Step 5.
(Continued on next page)
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(Continued on next page)

5 Do you want to check in the translation object associated with the 
map you are checking in?
◗ If YES, make sure that the check box next to the translation 

object is checked and then click Finish.
◗ If NO, click the check box to remove the check mark and then 

click Finish.

System Response
GENTRAN:Server displays this dialog box.

6 Do you want to remove the copies of the working files from the 
working directory after the files are checked in?

◗ If YES, click the Yes button.
◗ If NO, click the No button.

System Response
The system displays the Check-in Map and TBL/TPL File Status 
dialog box.

7 Do you want to print the status report?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
Step Action
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Checking in
maps and

compiled maps
in UNIX

Use this procedure to replace a map in the master directory with a modified 
working map.

���� �����	

1 Click Check In from the Main File menu and select Map as the 
type of file to check in.

System Response
The system displays the Select Map Files to Check In dialog box. 

Note
The list on the left shows only the maps that are in your working 
directory.

WARNING
If you are using both the Application Integration Mapper 
and the Visual Mapper, you must be careful NOT to 
overwrite your .vmp map. If the master directory 
contains a map with the same name as your working 
map, then you must use a different name for your 
working map. This prevents the .map file from 
overwriting the .vmp file. 
For example, if you are creating a new map in the 
Application Integration Mapper using the XXX.vmp as a 
guide, then save the new map using the file name 
XXY.map or XXXa.map.
GENTRAN:Server does not recognize map extensions. 
When you check in a working map to the master 
directory, it overwrites any existing map file that has the 
same file name, regardless of the extension.

(Continued on next page)
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2 Use this table to determine your next step.

IF you want to� THEN�

Check in a map Select the map you want to 
check in from the list and click 
Add.

Repeat this step for each 
additional map you want to 
check in.

Check in all the available maps Click Add All.

3 Click Next.

System Response
GENTRAN:Server displays the Select TBL/TPL Files to Check In 
dialog box.

4 Do you want to check in the translation objects (compiled maps) 
associated with the maps you selected?

◗ If YES, make sure that the check box next to the name of the 
translation object is checked.

◗ If NO, remove the check box from the translation objects that 
you do not want to check in.

(Continued on next page)


���	�
�

���� �����	
GENTRAN:Server Getting Started Guide � February 2002



How to Check In Compiled Maps Working with the Visual Mapper4 - 48
5 Click Finish.

System Response
The system moves the selected files from the working directory on 
the client to the user directory on the Host. After the files have been 
transferred successfully, the system moves them from the user 
directory to the master directory and unlocks the master files.
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How to Check In IG/Application Description Files

Introduction When you are satisfied with an implementation guide or application description 
file, you check in the working file. When you check in a working file, the system 
copies the file from the working directory to the master directory, replacing the 
original file. The working file becomes the new  implementation guide or 
application description. You can choose to leave a copy of the file in the working 
directory or remove it.

Checking in an
IG or application

description in
Workstation and

UNIX

Use this procedure to check in an implementation guide or application description 
file.

Step Action

1 Select Check In from the GENTRAN:Server Main File menu and 
click either Implementation Guide or Application Description

System Response
GENTRAN:Server displays the Select <filename> File to Check in 
dialog box

(Continued on next page)
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2 Use this table to determine your next step.

IF you want to check in� THEN�

a single implementation guide or 
application description file 

Select the implementation guide 
or application description file 
you want to check in from the 
list in the left pane and click 
Add.

Repeat this step for each 
additional file you want to check 
in.

all the available implementation 
guide or application description 
files

Click Add All.

(Continued on next page)
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3 Use this table to determine your next step.

IF you want to� THEN click�

Remove the working files from 
the working directory after they 
are checked in

Check in and Remove

Leave the working files in the 
working directory after they are 
checked in

Check in and not Remove

System Response
GENTRAN:Server displays the Check-in  <filename> File Status 
dialog box.

4 Do you want to print the status report?
◗ If YES, click Print.
◗ If NO, click Close.

 (Contd)
Step Action
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How to Check In Synonym and Thesaurus List Files

Introduction When you are satisfied with a synonym or a thesaurus list file, you check in the 
working file. When you check in a working file, the system copies the file from the 
working directory to the master directory, replacing the original file. The working 
file becomes the new file definition. You can choose to leave a copy of the file in 
the working directory or remove it.

checking in a
generic

synonym list or
thesaurus list in
Workstation and

UNIX

Use this procedure to check in a generic synonym or a thesaurus list file.

Step Action

1 Select Check In from the GENTRAN:Server Main File menu and 
click the file you want to check in:

◗ Generic Synonym List
◗ Thesaurus List

System Response
GENTRAN:Server displays the Select <filename> File to Check in 
dialog box.

2 Select the generic synonym file or thesaurus file you want to check 
in.

(Continued on next page)
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3 Use this table to determine your next step.

IF you want to� THEN click�

Remove the working files from 
the working directory after they 
are checked in

Check in and Remove

Leave the working files in the 
working directory after they are 
checked in

Check in and not Remove

4 System Response

GENTRAN:Server displays the Check-in <filename> File Status 
dialog box.

5 Do you want to print the status report?

◗ If YES, click Print.
◗ If NO, click Close.

 (Contd)
Step Action
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Glossary

Glossary
application The business software generating the business information that you are sending 
or receiving electronically.

check in The act of returning a copy of a file from your working directory to the master 
directory, making it available to other users.

check out The act of copying a file from the master directory to your working directory, 
making the file unavailable to other users.

client The computer in a client/server network that acts as the interface between the 
user and the server.

client/server A computer network architecture in which data is stored and processing is 
performed on the server, which users access through the interface provided on 
the client. 

default A value that is automatically assigned.

EDI Electronic Data Interchange.

Application-to-application transfer of key business transaction information in a 
standard or XML format via a computer-to-computer communication link.

EDI standard A format to regulate syntax, structure, and content of transaction data.
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lock The act of making a file unavailable to other users. A file is locked once it is 
checked out.

map A file that contains the relationships between:
◗ The segments and elements of a standard EDI document and the data fields 

in your application,
◗ The elements in an XML document and the data fields in your application, EDI 

standard document, or in another XML document,
◗ The segments and elements of two different standards, or
◗ The records and fields of two different applications.

master directory The directory on a PC or on a server that stores your master files.

master file The version of a file that GENTRAN:Server uses to process data. 

server The computer in a client/server network that performs the major system security, 
data storage, and computing tasks.

standard format A format intelligible to computerized data management systems.

temporary file A file on the client that GENTRAN:Server uses during editing and compiling.

trading partner The company, division, or group with which you are exchanging business data 
electronically.

Trading
Partnership

An arrangement to exchange information in a specific document type with a 
specific trading partner and using a particular standard version.
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user directory The directory on the server that temporarily holds the files being transferred from 
a client�s working directory to the master directory on the server.

working file A file that is stored in the user�s working directory on the client while the user has 
it checked out for editing.

working file
directory

The directory created on the client to hold the files that a user is editing.

unlock The act of making a file available to other users. A file is unlocked once it is 
checked in.
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Index

Index
A
access

rights 3-4, 4-3
type of 3-4, 4-3

application description
checking in 4-49
checking out 4-26
length of file name 1-20
unlocking 4-38
viewing 4-31

C
check in

in UNIX 3-30, 4-42
in Workstation 3-3, 3-30, 4-2, 4-42

checking in
application descriptions 4-49
compiled maps 4-42
file definitions 3-37
generic synonym list 4-52
implementation guides 4-49
in UNIX 3-6, 4-5
maps 3-30, 4-42
thesaurus list 4-52
translation objects 3-30

checking out 3-18
application descriptions 4-26
file definitions 3-18
file in UNIX 3-18, 4-26
file in Workstation 3-18, 4-26
generic synonym list 4-33
implementation guides 4-26
maps 3-18, 4-26
TBL/TPL files 3-8
thesaurus list 4-33

compiled map 3-29, 4-41
checking in 4-42
copying to host user directory 4-41

copying
translation object 3-29, 4-41

D
data manager

length of file name 1-20
data manager pattern

length of file name 1-20
deleting

working copies 3-26, 4-37
directory name length 1-19

E
editing a file 2-26

F
File Browser 2-23, 2-25, 2-26

caution for using 1-17
exiting 2-27
opening a file 2-25
saving a file 2-27
starting 2-25
when to use 2-23

file check out
in Workstation 3-3, 4-2

file checkout
in UNIX 3-5, 4-4

file definition
checking in 3-37
checking out 3-18
length of file name 1-20
unlocking 3-26
viewing 3-23

File name
character restrictions 1-21
conventions 1-19
invalid characters 1-21
length 1-20
validation 1-19

G
generic synonym list

checking in 4-52
checking out 4-33
unlocking 4-38
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Index 2
H
host computer 1-11

I
implementation guide

checking in 4-49
checking out 4-26
length of file name 1-20
unlocking 4-38
viewing 3-23, 4-31

input file
length of file name 1-20

ISAM files
editing caution 1-17

M
Main Window buttons 2-17
map

check in 3-3, 4-2
checking out 3-18, 4-26
length of file name 1-20
unlocking 3-26, 4-38
viewing 3-21, 4-29

mapping table
length of file name 1-20

master directory
in Workstation 3-3, 4-2

master file
unlocking 3-26, 4-37

master files
in UNIX 3-4, 4-3

O
On-line Help

using 2-21
output file

length of file name 1-20

Q
queue

length of file name 1-20

S
saving a file 2-27

application descriptions 4-35
file definition 3-24
generic synonym list 4-35
implementation guides 4-35
map 4-35
maps 3-24
thesaurus list 4-35

script
length of file name 1-20

Select Application Description Files to Check in 
dialog box 4-17
Select Application Description Files to Unlock 
dialog box 4-23
Select Application Description to Check out 
dialog box 4-9
Select File Definition Files to Check in dialog box 
3-14
Select File Definition Files to Unlock dialog box 
3-16
Select Generic Synonym File to Check out dialog 
box 4-11
Select Generic Synonym Files to Check in dialog 
box 4-19
Select Generic Synonym Files to Unlock dialog 
box 4-25
Select Implementation Guide Files to Check in 
dialog box 4-17
Select Implementation Guide Files to Check out 
dialog box 4-9
Select Implementation Guide Files to Unlock 
dialog box 4-23
Select Map Files to Check in dialog box 3-10, 4-13
Select Map Files to Check out dialog box 3-8, 4-7
Select Map Files to Unlock dialog box 3-16, 4-21
Select TBL/TPL Files to Check In dialog box 3-12, 
4-15
Select Thesaurus Files to Check in dialog box 
4-19
Select Thesaurus Files to Check out dialog box 
4-11
Select Thesaurus Files to Unlock dialog box 4-25
Status Bar

using 2-20

T
TBL/TPL

checking out 3-8
thesaurus list

checking in 4-52
checking out 4-33
unlocking 4-38

Toolbar 2-17
using 2-19

transaction register
length of file name 1-20

translation object
checking in 3-30
copying to host user directory 3-29
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Index  3
U
UNIX

check in 3-30, 4-42
checking in 3-6, 4-5
file check out 3-5, 4-4
master files 3-4, 4-3
working files 3-5, 4-4

unlocking
a generic synonym list 4-38
a thesaurus list 4-38
application descriptions 4-38
file definitions 3-26
implementation guides 4-38
maps 3-26, 4-38
master files 3-26, 4-37

using
online-help 2-21
Status Bar 2-20
Toolbar 2-19

V
viewing

application description 4-31
file definitions 3-23
implementation guide 3-23, 4-31
maps 3-21, 4-29

W
Window 2-23
working

in Workstation 3-3, 4-2
working copy

deleting 3-26, 4-37
working directory

in Workstation 3-3, 4-2
working file

saving 3-24, 4-35
working files

in UNIX 3-5, 4-4
Workstation

check in 3-3, 3-30, 4-2, 4-42
file check out 3-3, 4-2
working directory 3-3, 4-2
working in 3-3, 4-2
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